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LIMITED WARRANTY
Opcode Systems, Inc. warrants the
Studio 64 XTC against defects in materials and
workmanship for a period of one (1) year from
the date of original retail purchase.
If you discover a defect, first write or call
Opcode Systems, Inc. at (650) 856-3333 to
obtain a Return Merchandise Authorization
Number (no service will be performed on any
product returned without prior authorization).
If the product needs to be returned to Opcode,
please attach your name, address, telephone
number, a description of the problem, and a
copy of the dated bill of sale as proof of purchase. Write the Return Merchandise
Authorization (RMA) Number clearly on the
outside of the package and all correspondence.
Upon receiving the returned product, Opcode
Systems, Inc. will then, at its option, repair,
replace, or refund the purchase price of the
product.
This warranty applies only to the
Studio 64 XTC; Opcode software is warranted
separately.
This warranty does not apply if the product has
been damaged by accident, abuse, misuse, or
misapplication, or has been modified without
the written permission of Opcode Systems,
Inc.
All implied warranties, including implied warranties of merchantability and fitness for a
particular purpose, are limited in duration to
one (1) year from the original date of retail purchase of this product. The warranty and
remedies set forth above are exclusive and in
lieu of all others, oral or written, express or
implied.

Opcode Systems, Inc. is not responsible for
special, incidental, or consequential damages
resulting from any breach of warranty, or
under any legal theory, including lost profits,
downtime, good-will, damage to or replacement of equipment and property.
Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the
above limitation or exclusion may not apply to
you. This warranty gives you specific legal
rights, and you may also have other rights
which vary from state to state.
Except to the extent prohibited by law, all
implied warranties made by Opcode Systems,
Inc. in connection with this manual and software are limited in duration to ninety (90) days
from the date of original purchase, and no warranties, whether express or implied, shall
apply to this product after said period.
Opcode Systems, Inc. makes no warranty or
representation, either express or implied, with
respect to the software described in this manual. This software is sold “as is.” The
purchaser assumes the entire risk as to its
quality and performance. Under no circumstances shall Opcode Systems, Inc. be liable
for any loss or damage, direct, consequential,
or incidental, arising out of the use or inability
to use this product.
Some states do not allow limitations on how
long an implied warranty lasts or the exclusion
or limitation of incidental or consequential
damages, so the above limitations or exclusions may not apply to you.

TRADEMARKS

Declaration of Conformity

Studio 64 XTC is a trademark of Opcode Systems, Inc. IBM
is a registered trademark of International Business
Machines Corporation. Windows is a trademark of
Microsoft Corporation. Macintosh is a trademark of Apple
Computer, Inc. Other product and brand names are trademarks or registered trademarks of their respective
companies.

We, Opcode Systems, Inc.,
3950 Fabian Way, Suite 100
Palo Alto, CA 94303 USA
(650) 856-3333

RADIO FREQUENCY INTERFERENCE
This equipment has been tested and found to comply with
the limits for a Class B digital device, pursuant to Part 15 of
the FCC Rules.

declare under our sole responsibility that the product
Opcode Studio 64 XTC
complies with Part 15 of FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any
interference received, including interference that may cause
undesired operation.

CSA RADIO FREQUENCY INTERFERENCE

These limits are designed to provide reasonable protection
against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

This Class B digital apparatus meets all the requirements of
the Canadian Interference-Causing Equipment Regulations.

•

We, Opcode Systems, Inc., of
3950 Fabian Way, Suite 100
Palo Alto, CA 94303 USA
declare under our sole responsibility that the product
Studio 64 XTC, a MIDI interface
for Macintosh and IBM PC compatible computers,
to which this declaration relates is in conformance with the
following
standards:
EN55022:1987
EN50082-1:1992
IEC 801-2:1984
IEC 801-3:1984
IEC 801-4:1988
following the provisions of the 89/336/EEC Directive.

•
•
•

Reorient or relocate the receiving antenna of the
affected radio or television.
Increase the separation between the equipment and
the affected receiver.
Connect the equipment and the affected receiver to
power outlets on separate circuits.
Consult the dealer or an experienced radio/TV technician for help.

Modifications: Changes or modifications not expressly
approved by Opcode Systems, Inc. could void the user’s
authority to operate the equipment, per FCC regulations.
Shielded Cables: Shielded cables must be used with this
equipment to maintain compliance with FCC regulations.

Cet appareil numérique de la classe B respecte toutes les
exigences du Règlement sur le matériel brouilleur du
Canada.

Declaration Of Conformity
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CHAPTER 1:

Introduction

ABOUT THE STUDIO 64 XTC
Thank you for purchasing Opcode’s
Studio 64 XTC, a dual platform MIDI
interface, patchbay, and digital sync processor. The Studio 64 XTC includes the
following capabilities:
•
•

•
•
•
•
•
•

•
•

Compatible with notebook, laptop,
and desktop Macs and PCs;
Reads, stripes, and generates all
SMPTE formats, also includes freewheeling and regeneration;
ADAT Sync port for MMC control of
one or more Alesis ADATs;
Word Clock sync out for digital tape
recorders and hard disk recorders;
Super Clock sync out for Digidesign
digital audio hardware;
Accepts sync input from Blackburst
(house sync) or composite video;
4 x 6 MIDI interface with support for
64 channels;
Stand-alone MIDI patchbay—recall
routings and filterings, or even stripe
SMPTE from front panel;
4 user programs accessible from front
panel for MIDI routing and filtering;
4 preset programs accessible from
front panel: PANIC, SMPTE, ALL,
and TUNE;
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•

•

•

Front panel status LEDs for SMPTE
and sync status, and MIDI IN/OUT
activity;
MME compatible driver for
Windows 3.1, Windows 95, and Windows for Workgroups;
OMS driver for Macintosh, including
support for OMS Studio Patches.

System Requirements
To use the Studio 64 XTC with a PC,
you need:
•
•
•

An IBM PC compatible with
16550 COM port;
Windows 3.1, Windows for Workgroups, or Windows 95;
MIDI instruments and cables.

To use the Studio 64 XTC with a
Macintosh, you need:
•
•
•
•

A 68020 Macintosh or faster, or a
Power Macintosh;
System 7.0.1 or later;
4 MB of available RAM;
MIDI instruments and cables.
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What’s Included
Your Opcode Studio 64 XTC package
includes:
•
•
•

•

•
•

•

•
•
•
•

Studio 64 XTC MIDI interface;
DC power adapter;
PC serial cable—a 10’ 9-pin DSub
male to 9-pin DSub female cable, all
pins wired straight through;
PC cable adapter—a 9-pin male to
25-pin female adapter for 25-pin serial
port connectors;
Macintosh serial cable—a 10’ 8-pin
mini-DIN (RS-422) cable;
PC floppy disk with Setup program
that installs MME compatible Windows driver, XTCDIAG diagnostics
software, and Studio 64 XTC Program
Editor;
Macintosh floppy disks with OMS
software and Studio Patches Manual
(PDF version);
Studio 64 XTC Reference Manual;
OMS Manual for Mac users;
Technical Support Information
booklet;
Registration card.

HOW TO USE THIS MANUAL
This manual does not attempt to teach
fully the fundamentals of MIDI or synchronization. If you’re new to either of
these topics, you should read magazines
specializing in music technology, or purchase basic MIDI and SMPTE books
from your local bookstore or music
dealer.
If using a Macintosh, you should be familiar with the basic operations of the
Mac OS; or if you’re using a PC, you
should have a general grasp of using the
Windows operating system.
This manual discusses how to connect,
configure, and use the Studio 64 XTC—it
describes Studio 64 XTC operations at the
time of its printing. However, updates and
changes may occur. Always look for hardware and software update information in
the Read Me files installed onto your hard
disk.
This manual is divided into four parts:
•

•

4

Part 1: Overview and Installation
(Chapters 1-6)—These chapters discuss the Studio 64 XTC’s front and
rear panels, configuration for both PC
and Macintosh, MIDI instrument connections, and a quick test run of the
unit.
Part 2: Studio 64 XTC Programs
(Chapters 7-9)—These chapters discuss the Studio 64 XTC’s user and
preset programs, how they are
selected, initialized, edited, and
stored.

Opcode Systems, Inc.
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•

•

Part 3: Synchronization
(Chapters 10-13)—These chapters
provide a guide to using the synchronization capabilities of the
Studio 64 XTC, which include
SMPTE, MIDI Machine Control,
Word Clock and Super Clock sync,
and Blackburst and video sync.
Part 4: Appendices
The appendices cover Studio 64 XTC
troubleshooting, networking, installing/removing Windows drivers,
checking for PC serial devices, and
OMS Studio Patches for Mac.

OMS and Studio Patches Manuals (Mac)
Macintosh users must install and configure the Open Music System (OMS) to use
the Studio 64 XTC.
Included with your Studio 64 XTC package is a printed OMS Manual and an
online (PDF) version of the
Studio Patches Manual. Please read these
manuals to take full advantage of the
Studio 64 XTC’s Mac capabilities.

CUSTOMER SUPPORT AND
REGISTRATION
Registering your Studio 64 XTC
Please complete and return your registration card right away. Doing so will enable
Opcode to deliver the best possible support to you; it also ensures you’ll receive
important update/upgrade notices.
IMPORTANT: Please write down your
Studio 64 XTC serial number here. The
serial number is on the bottom of the
Studio 64 XTC.
S/N _______________________________
Purchase Date ______________________
Contacting Opcode
Opcode provides a variety of phone, fax,
and online support options. Consult your
Technical Support Information booklet on
how best to contact Opcode.
Figure 1.1:

For a brief explanation of OMS Studio
Patches, see Appendix E: OMS Studio
Patches for Macintosh.

Studio 64 XTC Manual
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CHAPTER 2:

Panel Descriptions

FRONT PANEL

Figure 2.1: Studio 64 XTC Front Panel

Following is a description of the front
panel components of the Studio 64 XTC:

Program Button
The PROGRAM button selects the current program or sync function. Press the
button once and an LED flashes rapidly to
indicate the currently selected program.
Press the PROGRAM button repeatedly
to advance to and select a particular program or sync function.

MIDI Output LEDs
The green output LEDs flash when MIDI
data is transmitted by the Studio 64 XTC.
The output LEDs also indicate when a
preset program is selected.

Sync Function LEDs
The red Sync Function LEDs indicate
when one of the three sync functions is
selected (by the PROGRAM button).
Unlike the LEDs for MIDI input/output,
the LED for the currently selected sync
function is always lit.
The sync functions include Sample Rate,
Sync Ref, and SMPTE. See Sync Status
LEDs (pg. 8) for an explanation of the different sync function options.

MIDI Input LEDs
The red input LEDs flash when MIDI data
is received by the Studio 64 XTC. The
input LEDs also indicate when a user program is selected.

Sync Button
The SYNC button is used to edit settings
for the three sync functions: Sample Rate,
Sync Ref, and SMPTE.
Once a sync function is selected with the
PROGRAM button, press the SYNC
button to step through and choose from
the various sync options.

Studio 64 XTC Manual
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Sync Status LEDs

Sync Ref Function

The green Sync Status LEDs provide a
means for monitoring and editing sync
settings. Following is a description of the
options for each sync function.

When the sync function is Sync Ref, one
or two of the sync status LEDs is lit
steadily to indicate the Studio 64 XTC’s
referenced sync sources for address (playback location) and time base (playback
speed).

Sample Rate Function
When the sync function is Sample Rate,
the sync status LEDs indicate the sample
rate of the Word Clock and Super Clock
generated by the Studio 64 XTC; whether
Pull Up or Pull Down is used; and if an
Alesis ADAT is connected and online.
The sync status LEDs are lit steadily
when a sample rate or Pull Up/Down
mode is selected. Use the SYNC button to
step through any of the following combination settings: 44.1, 44.1/P-UP, 44.1/
P-DN, 48, 48/P-UP, or 48/P-DN.
For more information on Word Clock,
Super Clock, and Pull/Up Down, see
Word Clock and Super Clock (pg. 51).
The ADAT status LED is lit when an
ADAT (turned on) is detected by the
Studio 64 XTC’s ADAT Sync port. To take
the ADAT offline, press the SYNC button
repeatedly until the ADAT LED is
selected—as a result, the LED will blink
slowly, indicating the ADAT is offline. For
more details, see Taking the ADAT Offline
(pg. 66).
If the ADAT is not turned on, or correctly
connected to the Studio 64 XTC, the
ADAT status LED will not be lit.

8

For a detailed explanation of how the
Studio 64 XTC works with address and
time base sources, see Time Base and
Address (pg. 49) and Sync Reference Modes
(pg. 50).
Following are the available choices for
sync source references:
•
•
•

•

Internal: Studio 64 XTC generates an
internal timing source.
SMPTE: SMPTE time code from the
SMPTE IN jack is referenced.
MTC: MIDI Time Code received
from one of the four MIDI inputs, or
from a computer program, is
referenced.
Video: Blackburst or composite video
signal received from the Blackburst/
Video IN port is referenced.

Use the SYNC button to step through the
following Sync Ref combination settings:
Int, Int/Video, SMPTE, SMPTE/Video,
MTC, MTC/Video.
If the Sync Reference mode is set to
receive Video, the Video LED is lit constantly when receiving the composite or
Blackburst signal. When these signals are
not present, the Video LED blinks slowly.

Opcode Systems, Inc.
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SMPTE Function

Power On/Off Switch

When the sync function is SMPTE, the
sync status LEDs indicate the frame rate
of received and transmitted SMPTE (or
MTC). The LED flashes rapidly when
receiving time code and slowly when generating time code.

The POWER switch turns on/off the
Studio 64 XTC. When powering up, all
LEDs flash simultaneously four times.
Make sure power is off before making any
connections.

Use the SYNC button to override the
SMPTE format of the current user
program.

REAR PANEL

Supported frame rates include:
•
•
•
•
•

30 Frames/second (Non-Drop)
29.97 Frames/second (Non-Drop)
29.97 Drop Frame
25 Frames/second
24 Frames/second

For an explanation of the different
SMPTE formats and related terminology,
see About SMPTE (pg. 47).
NOTE: When receiving 29.97ND, the
Studio 64 XTC always detects it as 30ND.
It is not possible for hardware or software to
tell the difference between these two SMPTE
formats.

Figure 2.2: Studio 64 XTC Rear Panel

Following is a description of the rear
panel connectors of the Studio 64 XTC:

9V DC 300MA
The provided DC adapter supplies power
to the Studio 64 XTC via this jack.
The type of power supply included
depends on where you purchase your
Studio 64 XTC:
•

•

On LED
The yellow On LED glows steadily when
the Studio 64 XTC is powered on.

U.S. and Canada: 7.5cDC - 9vDC,
300mA, 5.5mm x 2.1mm center positive barrel plug.
Europe: 7.5cDC, 300mA, 5.5mm x
2.1mm center positive barrel plug.

SMPTE Out
The Studio 64 XTC sends SMPTE via this
1/4” unbalanced phone jack when striping or generating sync.

Studio 64 XTC Manual

9

PART 1: Overview and Installation

To facilitate setting levels, the
Studio 64 XTC emits a constant leader
tone when not striping or generating
SMPTE.

To connect to the ADAT, use a standard
PC serial cable like the one included with
your Studio 64 XTC package (a 9-pin
DSub male to 9-pin DSub female cable, all
pins wired straight through).

SMPTE In
The Studio 64 XTC receives SMPTE via
this 1/4” unbalanced phone jack.
An optimum SMPTE signal has a level
between -10 db and -3 db, and should not
be processed by equalization, compression/limiting, or noise reduction.

Network
This RS-422 serial port lets the
Studio 64 XTC network to an Opcode
Studio 4, thereby allowing both interfaces
to share the same computer port.
For information on using the
Studio 64 XTC’s Network port, see
Appendix B: Networking.

Word Clock Out
Word Clock is transmitted via this BNC
connector to digital tape recorders and
hard disk recorders—thereby providing
frame accurate digital audio
synchronization.

Expansion
The Expansion port provides for possible,
future hardware options that will expand
the capabilities of the Studio 64 XTC.

ADAT Sync
The Studio 64 XTC uses this port to connect to the “Sync In” port of an
Alesis ADAT. Once connected, the
Studio 64 XTC provides MMC control
over the connected ADAT, and any additional daisy-chained ADATs.

10

Mac
This RS-422 serial port connects to your
Macintosh computer with the provided
(Mac) serial cable.
The included Mac cable is a 10’ 8-pin miniDIN (AppleTalk) cable, commonly used
to connect printers and modems.

PC
This 9-pin serial port connects to your
IBM PC 16550 COM port with the provided (PC) serial cable.
The included PC cable is a 10’ 9-pin DSub
male to 9-pin DSub female cable, all pins
wired straight through.
NOTE: If your COM port has a 25-pin connector, use the provided PC cable adapter
(a 9-pin male to 25-pin female adapter).

Opcode Systems, Inc.
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Super Clock Out
Digidesign’s proprietary Super Clock
signal is transmitted via this BNC connector (connects to the “Slave Clock” input of
Digidesign audio interfaces). This provides an extremely accurate means of
digital audio synchronization.

Blackburst/Video In
The Studio 64 XTC receives Blackburst
(house sync) or composite video via this
BNC connector.

DUAL COMPUTER
CONNECTION
The Studio 64 XTC can be connected to
either an IBM PC or Macintosh. What’s
more, the interface can even be connected to both types of computers at the
same time.
However, when connecting to both a Mac
and PC, the Studio 64 XTC can communicate with only one computer at a time.
Don’t worry though, the Studio 64 XTC’s
auto-sensing capability always knows
which computer to respond to.

MIDI Outputs
The Studio 64 XTC transmits MIDI to any
of four MIDI outputs. Each output port
(identified by number, 1 - 4) represents a
discrete set of 16 MIDI channels.
Two MIDI outputs (A and B) are provided
for ports 1 and 2. Therefore, devices sharing ports 1A and 1B, for instance, receive
the same MIDI information.

MIDI Inputs
The Studio 64 XTC receives MIDI from
any of four MIDI inputs. Each input port
(identified by number, 1 - 4) represents a
discrete set of 16 MIDI channels.

Studio 64 XTC Manual
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IBM PC Configuration

IBM PC CONFIGURATION
Connect Hardware
IMPORTANT: If you have other serial
devices (such as a mouse or modem) connected to a COM port on your PC, please
see Appendix D: PC Serial Ports on
page 91 before proceeding.
To connect the Studio 64 XTC to your PC:
a Turn off your computer, peripherals,
and MIDI instruments.

b Plug one end of the provided serial
cable into the PC port of your
Studio 64 XTC; plug the other end of
the serial cable into your computer’s
COM port.
Make note of whether you are connecting to COM1 or COM2.
If your COM port has a 25-pin connector,
use the provided PC cable adapter.

c Using standard MIDI cables, connect
the MIDI OUTs of your instruments to
the MIDI INs of the Studio 64 XTC;
then connect the MIDI INs of your
instruments to the MIDI OUTs of the
Studio 64 XTC.
For more details, see Chapter 5: MIDI
Instrument Connections.

Studio 64 XTC Manual
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d Plug the small end of the provided
power adapter into the
Studio 64 XTC’s 9VDC 300MA jack;
plug the other end into an AC power
source.
Make sure your power adapter is set to
or compatible with the AC voltage in your
area.

Run the Setup Program
To install the necessary PC software for
the Studio 64 XTC:
a Insert the PC disk and double-click
the Setup program.

e Turn on your computer, peripherals,
Studio 64 XTC, and MIDI
instruments—in that order.
For best results, use a power strip to turn
on/off all equipment simultaneously.

Serial Port Considerations (PC)
An IBM PC compatible may have up to
four COM ports: COM1 - COM4. Separate
COM ports can share the same IRQ, but
they cannot operate at the same time.
Generally, COM1 and COM3 are
assigned to IRQ4, while COM2 and
COM4 are assigned to IRQ3.
If your COM port has a 9-pin connector,
use the provided PC serial cable to connect to the Studio 64 XTC.
If your COM port uses a 25-pin connector,
plug the provided PC cable adapter
between your computer and the provided
PC serial cable, which plugs into the
Studio 64 XTC.

b When prompted, specify which
Studio 64 XTC software components
you wish to install and click Next.
First-time installers should install all
components.

c Specify an install directory and then
click Next.

d When prompted, specify which COM
port and IRQ you are using for the
Studio 64 XTC connection.
Generally, COM1 and COM3 default to
IRQ4, while COM2 and COM4 default to
IRQ3.

e Once you’ve specified the COM port
settings, click Next to install all
necessary software.
Files copied to your hard disk include the
Studio 64 XTC driver files, XTCDIAG
(diagnostics software), and 64xtc.exe
(Studio 64 XTC Program Editor).
Additionally, the necessary changes are
made to your System.ini file. A backup of
your original System.ini file (renamed to
“system.xtc”) is stored in your Windows
directory.

f When prompted, restart Windows for
changes to take effect.

14
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USING WINDOWS SOFTWARE
Once you’ve installed the Studio 64 XTC
driver, the following ports are available in
Windows MIDI applications:
•
•

•

•
•

•

•

64XTC In1 - In4: Receives MIDI
from the specified input ports.
64XTC Sync Port: Receives MIDI
Time Code, corresponding to
received or generated SMPTE; also
receives responses to sysex messages sent to it via the Control Port.
64XTC ADAT In Port: Receives
timing and location information from
the ADAT connected to the
Studio 64 XTC’s ADAT Sync port.
64XTC Out1 - Out4: Sends MIDI to
the specified output ports.
64XTC Broadcast Port: Sends
MIDI to all output ports
simultaneously.
64XTC ADAT Out Port: Sends
MMC commands to the ADAT connected to the Studio 64 XTC’s ADAT
Sync port.
64XTC Control Port: Sends system
exclusive messages to the
Studio 64 XTC governing its operation. Most users will not use this port
and should not select it.

back, specify the correct Out port for the
desired instrument. And if you intend to
sync to SMPTE, you should select the
Sync Port.
NOTE: If you are ever unsure of where
MIDI is being sent or from where it is being
received (or if you are receiving SMPTE
time code), just look at the LEDs on the
front panel of the Studio 64 XTC.
For details on selecting and assigning
MIDI ports in Windows applications, consult your software manuals.

OMS Applications under Windows
When using OMS applications under
Windows, such as Vision 2.5.1, device
names from the current Studio Setup are
used instead of Windows MIDI port
names.
For instance, when creating a new Studio
Setup in OMS, the Studio 64 XTC appears
with seven ports, each with an attached
device (see Figure 3.1).

It’s important to grasp that these various
input/output options designate how MIDI
is communicated between the
Studio 64 XTC and Windows applications.
When recording performance data, make
sure you enable the In port to which your
main keyboard controller is attached.
When assigning MIDI tracks for play-

Studio 64 XTC Manual

Figure 3.1: OMS Studio Setup containing a
Studio 64 XTC under Windows

15

PART 1: Overview and Installation

These devices (shown in Figure 3.1)
directly correspond to the MIDI ports
appearing in other (non-OMS) Windows
applications.
•
•
•
•

Ports 1-4: MIDI in/out ports 1-4
Port 5: ADAT in/out port
Port 6: Sync in/control out port
Port 7: Broadcast out port

Depending on your needs, these OMS
devices can be renamed or deleted as
desired. Consult your OMS Manual for
details.

16

Opcode Systems, Inc.

CHAPTER 4:

Macintosh Configuration

MACINTOSH CONFIGURATION
Connect Hardware
To connect the Studio 64 XTC to your
Macintosh:
a Turn off your computer, peripherals,
and MIDI instruments.

b Plug one end of the provided serial
cable into the MAC port of your
Studio 64 XTC; plug the other end of
the serial cable into your computer’s
modem or printer port.

c Using standard MIDI cables, connect
the MIDI OUTs of your instruments to
the MIDI INs of the Studio 64 XTC;
then connect the MIDI INs of your

Studio 64 XTC Manual

instruments to the MIDI OUTs of the
Studio 64 XTC.
For more details, see Chapter 5: MIDI
Instrument Connections.

d Plug the small end of the provided
power adapter into the
Studio 64 XTC’s 9VDC 300MA jack;
plug the other end into an AC power
source.
Make sure your power adapter is set to
or compatible with the AC voltage in your
area.

e Turn on your computer, peripherals,
Studio 64 XTC, and MIDI
instruments—in that order.
For best results, use a power strip to turn
on/off all equipment simultaneously.
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Serial Port Considerations (Mac)

About OMS

Either of the Mac’s two serial ports,
modem or printer, may be connected to
the Studio 64 XTC. When configuring
OMS for the first time, you must specify
which port (modem or printer) you are
using. If a particular port is unavailable for
MIDI, OMS will inform you.

To use the Studio 64 XTC with a Macintosh you must install and configure the
Open Music System (OMS). OMS keeps
track of how your MIDI studio is connected and configured and stores this
information in Studio Setup documents.
Studio Setups are created and edited in
the OMS Setup program.

A port may be unavailable for MIDI if you
are using AppleTalk, fax/modem software, or other MIDI management
software. For more details, consult your
OMS Manual.

Install and Configure OMS
To install and configure OMS:
a Insert the provided OMS disk 1 and

If turned on and connected properly, the
Studio 64 XTC is automatically detected
by OMS when configuring a new Studio
Setup. Once OMS knows that you’re
using a Studio 64 XTC, a Studio 64XTC
menu appears in the OMS Setup
application. Use this menu to store and
retrieve user programs, open the Program Edit and SMPTE Windows, and
check the unit’s ROM version.

double-click Install OMS.
At the initial prompt, specify you are
using a Studio 64 XTC.

b When reaching the main install
screen, choose the “Easy Install”
option and then click the Install
button.

c Insert each disk as prompted.
d When completed, exit the installer and
restart your Macintosh.

e After restarting, launch the
OMS Setup application and
configure a “New Studio Setup.”

OMS Studio Patches
OMS Studio Patches provide advanced
MIDI processing capabilities for the
Studio 64 XTC (implemented on the Macintosh only).
For a short summary of Studio Patches,
see Appendix E: OMS Studio Patches for
Macintosh. For a complete and thorough
explanation, consult the PDF version of
the Studio Patches Manual included with
your Studio 64 XTC package.

Consult your OMS Manual for help with
Studio Setup configuration.
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STUDIO 64 XTC AS A SECOND
INTERFACE
If you have an existing MIDI interface,
you can use the Studio 64 XTC as a
second interface. Simply connect one
interface to the modem port and the other
to the printer port. Then when configuring OMS, make sure to enable both ports
before searching for interfaces.
For information on connecting additional
MIDI interfaces to the Network port of
the Studio 64 XTC, see
Appendix B: Networking.

USING MACINTOSH MIDI
SOFTWARE
OMS-Compatible Applications
Once you have configured an OMS
Studio Setup, using OMS-compatible
applications is quite seamless. Any
devices contained in your Studio Setup
document are automatically available in
OMS applications, and you can even
select them by name. If at some point you
make changes in your current Studio
Setup, OMS applications are updated.
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If you wish to receive SMPTE time code
in an OMS application, the Studio 64 XTC
appears as a sync source.
If you are using Studio Patches and have
created a Studio Patches document, any
of its “virtual instruments” and “virtual
controllers” are also accessible from OMS
applications.

Non-OMS Applications
The Studio 64 XTC is compatible with
non-OMS applications. When using such
an application, the Studio 64 XTC acts like
a standard MIDI interface—thereby providing only 16 MIDI channels. In
“standard interface mode,” the
Studio 64 XTC merges all MIDI inputs
into the computer; additionally, all transmitted MIDI is simultaneously sent to all
four outputs.
IMPORTANT: To use non-OMS applications, the current Studio 64 XTC user
program must route MIDI to and from the
computer.
Figure 4.1:
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MIDI Instrument Connections

MIDI INSTRUMENT
CONNECTIONS

Studio 64 XTC

The Studio 64 XTC is a multiport MIDI
interface. This means that each of its four
discrete input and output ports supports
16 MIDI channels, providing a total of 64
channels.

MIDI In
MIDI Out

MIDI Out

The Studio 64 XTC receives MIDI data
from MIDI inputs 1 - 4, and sends data to
MIDI outputs 1 - 4.
NOTE: Two MIDI outputs (A and B) are
provided for ports 1 and 2. Therefore,
devices connected to ports 1A and 1B, for
instance, receive the same MIDI
information.

MIDI Controller

Figure 5.1: Instruments sending MIDI data

Types of devices from which you will want
to receive MIDI include:
•

Receiving MIDI from your
Instruments

•

If you will receive MIDI data from any of
your instruments, connect their MIDI
OUTs to the MIDI INs of the
Studio 64 XTC.

•

Studio 64 XTC Manual

Drum Machine

Master keyboard controllers sending
performance data;
Devices sending timing information
like external sequencers, drum
machines, sync boxes, and MMC
compatible recorders;
Instruments transmitting system
exclusive data for storage purposes.
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Sending MIDI to your Instruments
If you will send MIDI data to any of your
instruments, connect their MIDI INs to
the MIDI OUTs of the Studio 64 XTC.
Studio 64 XTC

A common scenario necessitating this
two-way communication is when using
editor/librarian software.
IMPORTANT: When connecting both
MIDI ports of an instrument, always use
the same Studio 64 XTC port number.
Sharing Ports

MIDI Outs

MIDI In
MIDI In

If you have more than four instruments
that will receive MIDI data, two MIDI outputs are provided for ports 1 (1A and 1B)
and 2 (2A and 2B).

MIDI In

Studio 64 XTC

Figure 5.2: Instruments receiving MIDI data
MIDI

Types of devices to which you will want to
send MIDI include:
•
•

•

Instruments that will play back in
sequences and arrangements;
Devices that receive timing information like external sequencers, drum
machines, sync boxes, and MMC
compatible recorders;
Instruments retrieving system exclusive data for restoring patches or
configuration settings.

When to Connect both Ports
When you need to send and receive MIDI
from an instrument, connect both of its
MIDI jacks (OUT and IN) to the
Studio 64 XTC. And if both ports of a
MIDI instrument are connected, always
use the same port number.

22

Outs
MIDI In

MIDI In

Device 2, channels 9-16

Device 1, channels 1-8

Figure 5.3: Two instruments sharing the same port
(1A and 1B), assigned to different MIDI channels

Keep in mind that when instruments
share a single port, they receive identical
MIDI information. In these instances, the
16 MIDI channels must be shared
between the connected instruments;
therefore, make sure these instruments
are assigned to different MIDI channels.
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If you happen to have more than 6 devices
that must receive MIDI, you can use the
THRU port of an instrument to daisychain additional instruments.

If you own a Macintosh, OMS Studio
Patches provide even more advanced
MIDI processing. For a brief explanation,
see Appendix E: OMS Studio Patches for
Macintosh.

Studio 64 XTC

AUDIO CONNECTIONS
MIDI In

Thru

Device 1, channels 1-8
MIDI In

Device 2, channels 9-16

Figure 5.4: Two instruments sharing the same port
(via THRU), assigned to different MIDI channels

The Studio 64 XTC is a MIDI interface
and does not provide audio output. Therefore, any MIDI instruments used for
playback must have their audio outputs
connected to an amplifier, mixer, speakers or headphones. Consult your
instrument manuals for information on
audio connections.

Again, chained instruments sharing the
same port receive identical MIDI information and should therefore be assigned to
different channels.

MIDI ROUTING, MERGING AND
PROCESSING
In addition to functioning as a MIDI interface and digital sync processor, the
Studio 64 XTC can also act as a standalone MIDI patchbay.
Customized user programs can be
defined that include routings between any
MIDI input and output; user programs
can also store mutings for specific MIDI
channels and/or messages. See
Chapter 7: Studio 64 XTC Programs for
details.

Studio 64 XTC Manual
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A Test Run

Once the Studio 64 XTC is connected to
your MIDI instruments, you should check
to see that it’s functioning properly.
NOTE: Before proceeding, make sure you
do not have any MIDI feedback loops in
your cabling. A MIDI loop occurs when
data is erroneously routed back to its place
of origin. MIDI loops can cause stuck notes,
poor timing, or other unexpected behavior
from MIDI instruments.

d Using the PROGRAM button, select
the TUNE program—its LED flashes.
All MIDI output LEDs flash as the
Studio 64 XTC transmits continuous
A440 note messages on all channels for
each port. Any connected instruments
play these notes.

e Press the PROGRAM button once to
end the TUNE program.
The previous program (ALL) is then
reselected and its LED flashes.

f Press the PROGRAM button

VERIFYING MIDI CONNECTIONS
a Turn on the Studio 64 XTC along with
any connected MIDI instruments.
When powered on, the On LED glows
steadily.

b Press the PROGRAM button
repeatedly until the ALL preset
program is selected—once selected,
its LED flashes.

c Play some notes on a MIDI controller
connected to one of the MIDI INs of
the Studio 64 XTC.
As the notes are played, the corresponding MIDI input LED flashes; additionally,
all MIDI output LEDs flash since the ALL
program routes MIDI data from any input
to all outputs.

Studio 64 XTC Manual

repeatedly to select and activate the
SMPTE sync function. Then use the
PROGRAM button to select the
SMPTE preset program.
The “30” sync status LED blinks slowly,
indicating the Studio 64 XTC is generating SMPTE time code.

g Press the PROGRAM button once to
exit from SMPTE striping.

h Next select the PANIC program.
All MIDI output LEDs glow steadily for
several seconds as note-off messages
for all channels are sent to each port.
Once completed, the Studio 64 XTC
returns to the previous program.

NOTE: You can interrupt either the TUNE
or SMPTE programs by pressing the PROGRAM button once, which automatically
calls up the previously selected program.
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VERIFYING PC CONNECTIONS
WITH XTCDIAG
Before attempting to use your Windows
music software, you may wish to run
XTCDIAG.EXE to verify the connection
between the Studio 64 XTC and your PC.
This DOS diagnostics program verifies
your serial port connection and tests
MIDI input and output.
NOTE: The Setup program on your PC
floppy disk installs XTCDIAG into the specified hard disk location. For more details,
see Chapter 3: IBM PC Configuration.
a Exit Windows and restart your
computer in DOS mode.

b At the DOS prompt, type:
C:\64XTC\XTCDIAG

NOTE: This example uses the default
install location for XTCDIAG. If you specified a different install directory or hard
drive, please make the necessary
change in this step.

VERIFYING MAC
CONNECTIONS WITH TEST
STUDIO
An easy way to trouble-shoot MIDI communication on the Macintosh is with
Test Studio, which is enabled from the
Studio menu in the OMS Setup
application.
Once Test Studio is enabled, click on any
MIDI device in your Studio Setup document to test MIDI output, or play some
notes on your keyboard controller to
verify MIDI input.
If Test Studio is unsuccessful, choose
Studio>MIDI Cards & Interfaces to reestablish communication with the
Studio 64 XTC. Consult your OMS
manual for more details on using
Test Studio.
Figure 6.1:

c Then press the ENTER key.
The XTCDIAG program launches.

d When prompted, specify your COM
port and IRQ settings.
The XTCDIAG program tests the interface connection. If the interface is not
found, see Chapter D: PC Serial Ports
for checking possible serial port
conflicts.

e Once your connection is verified as
valid, use the program’s Trace
command to test MIDI input; and to
test MIDI output, use the Scale
command.
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USER PROGRAMS
The Studio 64 XTC has four user programs that specify how it processes MIDI
input and output, and how it works with
synchronization. User programs are
stored in nonvolatile memory and recalled
from the front panel with the PROGRAM
button. When a user program is selected,
its settings are always active—whether a
MIDI software program is running, or
even if the Studio 64 XTC is not connected to a computer.
User programs are displayed and edited
from the Program Edit Window, which
can be accessed from the:
•

•

Program Editor under Windows
(see Chapter 8, page 33),
or with the...
OMS Setup application on the Mac
(see Chapter 9, page 39).

IMPORTANT: If at any time you’d like to
restore the default factory user programs,
you can initialize the Studio 64 XTC. See
Initializing User Programs (pg. 32).
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Each Studio 64 XTC user program can
control the following:
•

•

•

•

•

MIDI Routing and Merging: Routings between any MIDI input and
output are defined in the Connection
Grid of the Program Edit Window.
Each defined connection can have its
own discrete settings for message
and channel mutings.
Message Filtering: MIDI messages
can be filtered for each defined
connection.
Channel Filtering: MIDI channels
can be filtered for each defined
connection.
Channel Shifting: For each defined
connection, channel specification for
MIDI messages can be shifted with
the channel bump option.
Sync Settings: Each user program
stores settings for Sync Reference,
Sample Rate and Pull Up/Down, Digital Phase Lock on/off, ADAT ID and
offset, and SMPTE settings (frame
rate, start time, freewheel, and MTC
routing).

29

PART 2: Studio 64 XTC Programs

DEFAULT FACTORY USER
PROGRAMS

•

The four default user programs shipped
with the Studio 64 XTC are configured
with the following routings:
•

Factory User Program 3
Each input is routed only to its
corresponding output. For instance,
IN1 > OUT1, IN2 > OUT2, etc.

Factory User Program 1
Inputs and outputs are routed to and
from the computer only, which is an
ideal configuration for MIDI
sequencing.
Figure 7.3: Routing for User Program 3

•

Factory User Program 4
This default user program is identical
to the ALL preset program, which
routes all inputs to all outputs.

Figure 7.1: Routing for User Program 1

•

Factory User Program 2
Each input is routed to all outputs
except for its corresponding output.
For instance, IN1 > OUT2, OUT3, and
OUT4.
Figure 7.4: Routing for User Program 4

NOTE: Each of the default factory user programs routes the ADAT port to and from
the computer, which is necessary for MMC
control of connected ADATs.

Figure 7.2: Routing for User Program 2
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Default Sync Settings

•

In addition to the routings contained in
each default user program, there are also
default sync settings.

•

The default sync settings, identical for
each of the four factory user programs,
are as follows:
•
•
•
•
•
•
•
•
•
•

Sync Reference Mode: Internal
SMPTE Frame Rate: 30 Non-Drop
SMPTE Start Time: 00:00:00:00
Freewheel: 10 frames
MTC Source: Computer
Digital Phase Lock: On
Sample Rate: 48 kHz
ADAT Online: On
ADAT ID: 0
ADAT Offset: 00:00:00:00

PRESET PROGRAMS
In addition to the four user programs, the
Studio 64 XTC also has four preset programs, which provide the following
special functions:
•

•

Preset Program 1: PANIC
When selected, an “all notes off” message is sent to each of the four MIDI
OUT ports to turn off stuck notes.
Preset Program 2: SMPTE
When selected, the Studio 64 XTC
stripes SMPTE according to the settings (frame rate, start time, free
wheel, and MTC routing) of the current user program.
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Preset Program 3: ALL
When selected, all MIDI INs are
routed to all MIDI OUTs.
Preset Program 4: TUNE
When selected, continuous A440 note
messages are sent to each port,
which can be used to verify that
instruments are connected, turned
on, and set to the proper volume
levels.

FRONT PANEL OPERATIONS
A variety of Studio 64 XTC operations can
be accessed from the front panel. You can
select user programs, access the preset
functions, monitor and adjust sync settings, and even initialize the factory user
programs.
NOTE: Although a user program’s sync settings can be adjusted from the front panel,
to actually store these settings you must use
your Macintosh or PC.
For more information, see
Chapter 8: Editing User Programs under
Windows or Chapter 9: Editing User Programs on the Macintosh.

Selecting a Program
The PROGRAM button selects the current program. Press this button once and
an LED flashes rapidly to indicate the currently selected program. Press the
PROGRAM button repeatedly to advance
to and select a particular program.
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When either the TUNE or SMPTE presets are selected, pressing the
PROGRAM button once will interrupt
these routines and return to the previously selected program.
After the PANIC preset is selected and
the “all notes off” messages are sent to
each port, the Studio 64 XTC returns to
the previously selected program.

Striping from the Front Panel
To begin striping SMPTE time code,
simply select the SMPTE preset program.
Time code is then automatically sent to
the Studio 64 XTC’s SMPTE OUT jack;
the frame rate used is that stored with the
SMPTE settings of the previously
selected program. The default user programs are each set to use 30-frame NonDrop with a Start Time of 00:00:00:00.
NOTE: Striping from the front panel
always uses the SMPTE settings from the
current user program.
To specify a particular format before striping, call up the SMPTE function and
choose the desired frame rate with the
SYNC button.
Monitoring/Editing Sync Settings
Settings for SMPTE, Sync Reference, and
Sample Rate can be viewed from the front
panel. To activate a sync function, push
the PROGRAM button repeatedly until
the desired function LED is lit.
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When a particular sync function is
selected, the sync status LEDs indicate its
current state. Use the SYNC button to edit
these sync settings by stepping through
the various options. For an explanation of
the three sync functions, see Sync Status
LEDs (pg. 8).

Initializing User Programs
The user programs for the Studio 64 XTC
are set to defaults at the factory. Using
your Macintosh or IBM PC, these user
programs can be edited to accommodate
your specific needs.
If after making changes to the user programs you would like to return the
Studio 64 XTC to its default state, you can
initialize the unit with the following
procedure:
a Turn off the Studio 64 XTC.
b Press the PROGRAM button and hold
it down while turning the unit back on.
Note that no LEDs are lit.

c After several seconds, release the
PROGRAM button.
All LEDs flash four times, indicating the
Studio 64 XTC user programs have
been initialized.

IMPORTANT: Initializing the
Studio 64 XTC is also recommended if, for
some reason, the user programs become
corrupted.

Opcode Systems, Inc.

CHAPTER 8:

Editing User Programs under
Windows

USING THE PROGRAM EDITOR
On the IBM PC, use the Studio 64 XTC
Program Editor to display, edit, and
store user programs.
To open the Program Editor:
a Locate the 64xtc.exe program icon in
the directory or folder specified
during installation; then double-click
it.
To open Program Editor,
double-click the 64xtc.exe icon

The Program Edit Window opens.

Program Sets
The Studio 64 XTC’s four user programs
are saved in files called “program sets.”
On startup, the Program Editor reads the
previously saved program set, which generally corresponds to the programs stored
in the Studio 64 XTC’s nonvolatile
memory.
If no program set exists, as when running
the program for the first time, the Program Editor automatically uses the
default factory user programs.
While in the Program Editor, you can
open previously saved program sets,
create a new file from default settings, or
send and retrieve program sets (or individual programs) from the Studio 64 XTC.
Storing Changes
When making changes to a particular
user program, the Program Editor echoes
these changes to the edit buffer of the
Studio 64 XTC. This way you can test out
the new settings as they are edited.

Figure 8.1: Program Edit Window for PC

The Program Editor is installed by running the Setup program from the
provided PC disk. For more details, see
Chapter 3: IBM PC Configuration.
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However, to actually save these changes
to nonvolatile memory you must use
either Settings>Store Program or Settings>Store All Programs. See Program
Editor Menu Reference (pg. 36).
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•

PROGRAM EDIT WINDOW (PC)
The following section describes each
component of the Program Edit Window.

2
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Figure 8.2: Program Edit Window for PC

A

Connection Grid: Defines connections, which route MIDI between
inputs (on left) and outputs (on top).
Click on any MIDI input or output to
rename it.

Selected and unselected connections

•

•
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Connections are indicated by MIDI
connectors—black is selected and
white unselected. Each connection
may have its own set of filterings for
MIDI messages and channels.
To define a connection, click with the
right mouse button on an empty grid
location.
To remove a connection, click on it
with the right mouse button.

To select a connection, click on it
with the left mouse button.
• To select several connections, Control-click with the left mouse button
on the desired connection(s).
In addition to the MIDI input and
output ports, the Connection Grid
also has a row and column for the
Alesis ADAT. This allows routing of
MMC to a connected ADAT (either
from the computer or from an external MIDI device).
B Message Filters: Specifies which
MIDI messages are routed for the
selected connection(s).
•
A check mark indicates the message is routed.
•
No check mark indicates the
message is not routed.
•
A gray check mark indicates the
message setting is different for the
selected connections.
• Checking the “All” option automatically routes all messages.
C Channel Filters: Specifies which
channels are routed for the selected
connection(s).
•
A check mark indicates the channel is routed.
•
No check mark indicates the
channel is not routed.
•
A gray check mark indicates the
channel setting is different for the
selected connections.
• Checking the “All” option automatically routes all channels.
D Channel Bump: Shifts the channel
assignment for MIDI messages for
the selected connection(s).
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E

Sync Reference: Determines the
Sync Reference mode for the
Studio 64 XTC. See Sync Reference
Modes (pg. 50) for an explanation of
each mode.
F Sample Rate: Determines the
sample rate, and whether Pull Up/
Down is used, for the transmitted
Word Clock and Super Clock. For
details, see Word Clock and Super
Clock (pg. 51).
G MTC Source: When the Sync Reference mode is specified as MTC or
MTC/Video, this pop-up determines
the source of the MTC (one of the
four MIDI IN ports, or Computer).
Choose “Computer” as the source
when receiving MTC from a software
application.
See MIDI Time Code (pg. 61) for
details.
H Digital Phase Lock: When checked,
this option provides the most accurate sync when using Word Clock
and Super Clock with digital audio
hardware.
If, however, you are not using digital
audio hardware, or an ADAT,
uncheck this item for faster lock-up
when syncing to SMPTE or MTC.
For more information, see Digital
Phase Lock (pg. 53).
NOTE: The Studio 64 XTC still generates Word/Super Clock when “Digital
Phase Lock” is disabled. In this mode,
however, audio sync is not as accurate.
IMPORTANT: Digital Phase Lock
must be checked if you are controlling
an Alesis ADAT from the
Studio 64 XTC.
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ADAT Online: Determines whether
the Studio 64 XTC sends control messages to a detected ADAT. For
details, see Taking the ADAT Offline
(pg. 66).
Adat Offset: Specifies an offset for
SMPTE transmitted to the ADAT
Sync port. For details, see ADAT
Offset (pg. 64).
ADAT ID: Sets the ID for the ADAT
connected directly to the
Studio 64 XTC. For details, see
ADAT ID (pg. 64).
SMPTE Button: Opens the SMPTE
Window.
SMPTE Monitor: Displays scrolling
SMPTE frames when receiving/generating time code. When receiving
time code, the SMPTE monitor
detects the frame rate.
NOTE: 29.97 Non-Drop is always
detected as 30 Non-Drop.
Program Name Field: Lets you type
in a new name for the current
program.
Preset/User Programs Button:
Specifies whether the preset or user
programs are displayed.
Program Buttons: Specifies which
program is currently displayed and
edited. Choosing a program also
sends it to the edit buffer of the
Studio 64 XTC, which does not store
it in nonvolatile memory (to do this
choose Settings>Store Current
Program).
Status Field: Displays communication status between the
Studio 64 XTC and PC.
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D

SMPTE Window
To open the SMPTE Window, click the
SMPTE button in the Program Edit
Window.

1
4

2

3

5
6
7

Figure 8.3: SMPTE Window for PC

Following is an explanation for each of the
components in the SMPTE Window:

Format: Specifies the frame rate to
be used when striping or generating
SMPTE.
E Send MTC To: Directs MIDI Time
Code (based on either received or
generated SMPTE) to the computer
and/or checked MIDI outputs.
F Stripe/Stop: Starts striping with the
current SMPTE settings; click the
button again to Stop.
G OK: Closes the SMPTE Window with
the current settings.
NOTE: Settings in the SMPTE Window,
along with those in the Program Edit Window, are saved with each user program.
This lets you, for instance, save a different
SMPTE format for each user program.

A

SMPTE Monitor: Displays scrolling
SMPTE frames when receiving/generating time code. When receiving
time code, the SMPTE monitor
detects the frame rate.
NOTE: 29.97 Non-Drop is always
detected as 30 Non-Drop.
B SMPTE Start: Specifies the SMPTE
start time when striping.
C Freewheel: Allows SMPTE synchronization to continue (freewheel)
when receiving bad time code. The
Freewheel setting determines the
number of dropped frames (None, 2,
6, 10, 30, 60) the Studio 64 XTC will
tolerate.
Choose “Jam Sync” if you would like
the Studio 64 XTC to continue generating time code indefinitely when its
SMPTE source has stopped.
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PROGRAM EDITOR MENU
REFERENCE
After launching the Studio 64 XTC Program Editor, the following menu items
are available:
File>New
Opens a new program set with default
settings.
File>Open
Opens a previously saved program set.
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File>Save

Settings>Name Program Set

Saves the current program set with its
current file name.

Lets you specify a descriptive name for
the current program set. The name
appears in the Program Editor’s title bar
along with the name of the current file.

NOTE: This command does not save these
programs to the nonvolatile memory of the
Studio 64 XTC; to do this use
Settings>Store All Programs.
File>Save As
Saves the current program set with a
specified file name.
NOTE: This command does not save these
programs to the nonvolatile memory of the
Studio 64 XTC; to do this use
Settings>Store All Programs.
File>Exit
Exits the Program Editor. If changes
made to the current program set were not
saved or sent to the Studio 64 XTC, you
are prompted.
Edit>Copy Program
Copies the currently displayed program
so it can be pasted into another program
location or program set.
Edit>Paste Program
Pastes a user program into the current
program location.
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Settings>Always On Top
When checked, ensures the Program Edit
Window is always visually on top of any
other open windows.
Settings>Store Current Program
Sends the currently displayed program to
the Studio 64 XTC’s nonvolatile memory,
where it is stored in the corresponding
program location.
Settings>Retrieve Current Program
Retrieves the corresponding
Studio 64 XTC user program from nonvolatile memory and updates the currently
displayed program.
Settings>Store All Programs
Sends the current program set to the
Studio 64 XTC where it is stored in nonvolatile memory.
Settings>Retrieve All Programs
Retrieves all four user programs from the
Studio 64 XTC’s nonvolatile memory and
places them in the current program set.
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Help>Quick Help
Displays help text on using the Program
Editor.
Help>About Studio 64XTC Program
Editor
Displays the version number for the Program Editor, and ROM version for the
Studio 64 XTC (which must be powered
on and correctly connected).
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Editing User Programs on the
Macintosh

USING OMS SETUP
To display, edit, and store Studio 64 XTC
user programs on the Macintosh, use the
Program Edit Window from the
OMS Setup application.
To open the Program Edit Window:
a Launch OMS Setup by doubleclicking its program icon.

b From within OMS Setup, choose
Studio 64XTC>Edit Programs.
The Program Edit Window opens.

Program Sets
The Studio 64 XTC’s four user programs
are saved in files called “program sets.”
On startup, OMS Setup reads the previously saved program set, which generally
corresponds to the programs stored in the
Studio 64 XTC’s nonvolatile memory. If
no program set exists, as when running
the program for the first time, OMS Setup
automatically uses the default factory user
programs.
While in the Program Edit Window, you
can open previously saved program sets,
create a new file from default settings, and
send and retrieve program sets (or individual programs) from the Studio 64 XTC.
Storing Changes
When making changes to a particular
user program in the Program Edit Window, these changes are echoed to the edit
buffer of the Studio 64 XTC—thereby
allowing you to try out the new settings as
they are edited.

Figure 9.1: Program Edit Window for Mac

The Studio 64XTC menu is only available if the current OMS Studio Setup
contains a Studio 64 XTC. For more
details, see Chapter 4: Macintosh
Configuration.
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However, to actually save these changes
to nonvolatile memory, you must use
either Studio 64XTC>Store Current
Program or Studio 64XTC>Store All
Programs. See Studio 64XTC Menu
(pg. 42).
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•

PROGRAM EDIT WINDOW
(MAC)
The following section describes each
component of the Program Edit Window.
1

2

3
7

5

6

4

8
9

J

K

Figure 9.2: Program Edit Window for Macintosh

A

Connection Grid: Defines connections, which route MIDI between
inputs (located on the left) and outputs (located at the top); names for
the MIDI inputs/outputs are taken
from the current Studio Setup.

Selected and unselected connections

•
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Connections are indicated by MIDI
connectors—black is selected and
white unselected. Each connection
may have its own set of filterings for
MIDI messages and channels.
To define a connection, click and drag
across empty grid locations.

To select a connection, click and drag
across the desired connector(s); to
deselect, click anywhere outside the
grid.
• Click and drag while holding down
the Shift key to add or remove from
the “selection,” depending on
whether the item clicked was
selected.
• To disconnect a selected connection,
click the scissors icon or type Backspace, Delete or Clear. You may
also remove a connection by doubleclicking it.
In addition to the MIDI input and
output ports, the Connection Grid has
a row and column for the Alesis
ADAT. This allows routing of MMC
to a connected ADAT (either from the
computer or from an external MIDI
device).
The Connection Grid can also route
MTC (from the specified MTC
Source) to any of the four MIDI OUT
ports.
B Message Filters: Specifies which
MIDI messages are routed for the
selected connection(s).
•
A green dot indicates the message is routed.
•
A red circle indicates the message is not routed.
•
A gray, empty area indicates the
message setting is different for the
selected connections.
• Selecting the “All” option automatically routes all messages.
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C

•
•
•

•
D

E
F

G

Channel Filters: Specifies which
channels are routed for the selected
connection(s).
A green dot indicates the channel
is routed.
A red circle indicates the channel
is not routed.
A gray, empty area indicates the
channel setting is different for the
selected connections.
Selecting the “All” option automatically routes all channels.
Channel Bump: Shifts the channel
assignment for MIDI messages for
the selected connection(s).
Rename button: Lets you rename
the current user program.
Program pop-up: Specifies which
program is being displayed and
edited. Choosing a program from this
pop-up menu also sends it to the edit
buffer of the Studio 64 XTC, which
does not store it in nonvolatile
memory (to do this choose
Studio 64XTC>Store Program).
Digital Phase Lock: When checked,
this option provides the most accurate sync when using Word Clock
and Super Clock with digital audio
hardware.
If, however, you are not using digital
audio hardware or an ADAT, uncheck
this item for faster lock-up when syncing to SMPTE or MTC. For more
info, see Digital Phase Lock (pg. 53).
NOTE: The Studio 64 XTC still generates Word/Super Clock when “Digital
Phase Lock” is disabled. In this mode,
however, audio sync is not as accurate.
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IMPORTANT: Digital Phase Lock
must be checked if you are controlling
an Alesis ADAT from the
Studio 64 XTC.
Sample Rate: Determines the
sample rate, and whether Pull Up/
Down is used, for the transmitted
Word Clock and Super Clock. For
details, see Word Clock and Super
Clock (pg. 51).
Sync Source: Determines the Sync
Reference mode for the
Studio 64 XTC. See Sync Reference
Modes (pg. 50) for an explanation of
each mode.
MTC Source: When the Sync Reference mode is specified as MTC or
MTC/Video, this pop-up determines
the source of the MTC (one of the
four MIDI IN ports, or Computer).
Choose “Computer” as the source
when receiving MTC from a software
application.
See MIDI Time Code (pg. 61) for
details.
Adat Offset: Specifies an offset for
SMPTE transmitted to the ADAT
Sync port. For details, see ADAT
Offset (pg. 64).
ADAT ID: Sets the ID for the ADAT
connected directly to the
Studio 64 XTC. For details, see
ADAT ID (pg. 64).
ADAT Online: Determines whether
the Studio 64 XTC sends control messages to a detected ADAT. For
details, see Taking the ADAT Offline
(pg. 66).
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D

SMPTE Window
To open the SMPTE Window, choose
Studio 64XTC>SMPTE Window.

1
2
3

5
6

4

Format: Specifies the frame rate to
be used for striping SMPTE.
E Start Striping Button: Starts striping with the current SMPTE settings;
to stop, click the Stop Striping button.
F Stop Striping Button: Stops SMPTE
striping; to begin striping SMPTE,
click the Start Striping button.
NOTE: Settings in the SMPTE Window,
along with those in the Program Edit Window, are saved with each user program.
This lets you, for instance, save a different
SMPTE format for each user program.

Figure 9.3: SMPTE Window for Mac

Following is an explanation for each of the
components in the SMPTE Window:
A

SMPTE Monitor: Displays scrolling
SMPTE frames when either receiving
or generating time code. When
receiving time code, the SMPTE
monitor detects the frame rate.
NOTE: 29.97 Non-Drop is always
detected as 30 Non-Drop.
B Freewheel: Allows SMPTE synchronization to continue (freewheel)
when receiving bad time code. The
Freewheel setting determines the
number of dropped frames (None, 2,
6, 10, 30, 60) the Studio 64 XTC will
tolerate.
Choose “Jam Sync” if you would like
the Studio 64 XTC to continue generating time code indefinitely when its
SMPTE source has stopped.
C Start Time: Specifies the SMPTE
start time when striping.
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STUDIO 64XTC MENU
When the current OMS Studio Setup contains a Studio 64 XTC, a Studio 64XTC
menu becomes available with the following items:
Studio 64XTC>Edit Programs
Opens the Program Edit Window, which
displays and edits user programs.
Studio 64XTC>SMPTE
Opens the SMPTE Window, from which
SMPTE may be read or generated.
Studio 64XTC>Open
Opens a previously saved program set.
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Studio 64XTC>Save

Studio 64XTC>Store Current Program

Saves the current program set with its
current file name.

Sends the currently displayed program to
the Studio 64 XTC’s nonvolatile memory,
where it is stored in the corresponding
program location.

NOTE: This command does not save these
programs to the nonvolatile memory of the
Studio 64 XTC; to do this choose
Studio 64XTC>Store All Programs.
Studio 64XTC>Save As
Saves the current program set with a
specified file name.

Studio 64XTC>Load All Programs
Retrieves all four user programs from the
Studio 64 XTC’s nonvolatile memory and
places them in the current program set.
Studio 64XTC>Store All Programs

NOTE: This command does not save these
programs to the nonvolatile memory of the
Studio 64 XTC; to do this choose
Studio 64XTC>Store All Programs.

Sends the current program set to the
Studio 64 XTC where it is stored in nonvolatile memory.

Studio 64XTC>Copy Program

Studio 64XTC>Display ROM Version

When the Program Edit Window is open,
copies the currently displayed program so
it can be pasted into another program
location or program set.

Displays the ROM version for the
Studio 64 XTC, which must be powered
on and correctly connected.

Studio 64XTC>Paste Program
When the Program Edit Window is open,
pastes a user program into the current
program location.
Studio 64XTC>Load Current Program
Retrieves the corresponding
Studio 64 XTC user program from nonvolatile memory and updates the currently
displayed program.

Studio 64 XTC Manual
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The Studio 64 XTC can synchronize a
variety of different audio equipment,
including computer sequencers, multitrack analog recorders, digital
multitracks, hard disk recorders, MMC
devices, and video decks.
The Studio 64 XTC’s sync settings specify
how all of these devices are kept in sync,
which devices are timing sources and
which are slaves.
Before exploring how the Studio 64 XTC
works with these various sync devices, we
should first examine the basics of SMPTE
time code—the most fundamental component of synchronization.

ABOUT SMPTE
SMPTE is a timing reference signal developed by the Society of Motion Pictures
and Television Engineers. It specifies a
format for recording digital timing information onto magnetic tape. Originally
designed for keeping film and video in
sync with audio, it is now commonly used
in a variety of audio specific applications.
A common scenario involving SMPTE
and MIDI entails synchronizing MIDI
tracks from a software sequencer with
music tracks from a multitrack recorder.
A tape track is striped with SMPTE time
code and then read back into the computer—usually by a MIDI interface with
sync capabilities. The time code provides
a reference to the sequencer of where the
tape is at any precise moment, allowing
tape events to synchronize with sequence
events.
Following are some SMPTE terms with
which you should become familiar.

Studio 64 XTC Manual
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Synchronization

SMPTE Formats

The means by which two or more signals
are locked together in time. One example
is how the frames in a film line up with the
audio track—thereby ensuring that what
you hear is synchronized with what you
see.

The Studio 64 XTC supports five SMPTE
frame rates, which include:
•

SMPTE Time Code
A digital signal, comprised of timing information, that is recorded onto magnetic
tape (multitrack recorders, video decks,
film, etc.). As illustrated in Figure 10.1,
consecutive time code frames mark locations in hours, minutes, seconds, and
frames (subdivisions of a second).

•

•

Figure 10.1: SMPTE time code frames

•

SMPTE Sync Track

•

A region of tape onto which is recorded
SMPTE time code for the purpose of synchronization. The time code provides a
reference for the occurrence of specific
tape events.

Figure 10.2: SMPTE sync track

30 Frame/second (Non-Drop): Original NTSC black and white television
standard. This format is often used in
audio-specific applications since there
are no dropped frames and the
SMPTE time is equal to real time.
29.97 Frames/second (Non-Drop):
Syncs to NTSC color television without dropping frames. SMPTE time
does not match real time, but playback pitch is unaffected.
29.97 Drop Frame: NTSC (North
American) color television frame rate.
This format runs at 30 Frame/second, but has the first two frames
dropped every minute, except at minutes 0, 10, 20, 30, 40 and 50.
25 Frames/second: EBU (European)
television frame rate.
24 Frames/second: Film frame rate.

SMPTE Start Time
The time represented by the first frame of
time code recorded on a SMPTE sync
track. The sync track should be recorded
so that the start time precedes the offset
by at least three seconds.
SMPTE Offset
The SMPTE time (location) on tape that
corresponds to the beginning of a song or
musical passage. The offset time should
occur at least three seconds after the
SMPTE start time.
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MIDI Time Code (MTC)
SMPTE time code that has been converted to MIDI messages for
communication between MIDI devices
and software.
Freewheel
A method by which a MIDI interface (or
sync device) continues to generate time
code when there is no SMPTE signal
present. This is very useful when attempting to sync to a tape containing bad time
code (yielding dropouts in the SMPTE
signal).

TIME BASE AND ADDRESS
There are two basic components involved
in accurately synchronizing multiple
devices for audio playback: address and
time base.
Address specifies location, which ensures
that all devices begin playing from a precise (SMPTE) location.
Time base provides an accurate measurement of time passage—thereby making
sure the duration of audio events is the
same (in sync) for all playback devices.
The Studio 64 XTC’s primary purpose is
to resolve the address and time base
sources and generate accurate Word/
Super Clock, SMPTE time code, and
MTC—which, as a result, synchronizes
all audio devices.
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An important thing to remember about
address and time base is that sometimes
(although not always) these sources will
come from two different sync devices. For
instance, it is very common to receive
SMPTE (address) from a video deck
while receiving Blackburst (time base)
from a house sync source.

Blackburst and Video Signals
Blackburst and composite video signals
allow video equipment to transfer video
images and also stay in sync with each
other (frame-locked).
Consumer VCRs and televisions use composite video to send and receive video
signals. Blackburst, on the other hand,
sometimes referred to as house sync, is a
more accurate video signal used by highend, professional video decks.
A Blackburst generator is used in video
production studios to provide a master
sync reference to all video devices, which
allows all equipment to be frame-locked.
The Studio 64 XTC accepts both Blackburst and composite video sync. This
allows video decks to accurately synchronize with MIDI sequencing software,
digital multitracks, and hard disk
recorders.
See Using Blackburst/Video Sync (pg. 71)
for a discussion of several Studio 64 XTC
scenarios with video sync.
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SYNC REFERENCE MODES
The Studio 64 XTC’s Sync Reference setting specifies the sources for address and
time base.
The following table illustrates the address
and time base for each of the Sync Reference modes for the Studio 64 XTC:

Sync Mode

Address

Time
Base

Internal

64XTC

64XTC

Int/Video

64XTC

Video

SMPTE

SMPTE

SMPTE

SMPTE/Video

SMPTE

Video

MTC

MTC

MTC

MTC/Video

MTC

Video

Table 1: Studio 64 XTC Sync Reference Modes

The Sync Reference mode can be set from
the front panel using the PROGRAM and
SYNC buttons. See Front Panel Operations (pg. 31).
The Sync Reference mode can also be set
from the Program Edit Window using
either your PC (see Chapter 8, pg. 33) or
Macintosh (see Chapter 9, pg. 39).
The following sections discuss each of the
Studio 64 XTC’s Sync Reference modes:
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Internal
Use Internal when you are not referencing an external SMPTE or MTC source. If
you are controlling an Alesis ADAT without involving any other tape or video
devices, you should use Internal. In this
mode, the Studio 64 XTC acts as the
source for both address and time base.

Internal/Video
This mode is used when syncing to either
a Blackburst or composite video signal
without referencing an external SMPTE
or MTC source. This mode should also be
used when you wish to stripe framelocked SMPTE time code onto video.

SMPTE
Choose this mode when receiving
SMPTE time code from the SMPTE IN
jack of the Studio 64 XTC. The source of
the time code in this instance would likely
be a multitrack recorder—not video.

SMPTE/Video
This mode is used for locking to a Blackburst or composite video signal while also
receiving SMPTE time code.
The SMPTE source may come from the
video deck providing the composite video
signal.
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MTC
Choose this mode when receiving MTC
from one of the MIDI IN jacks of the
Studio 64 XTC, or from a software program on your Mac or PC.
Keep in mind that in order for this to
work, the current user program must
specify the desired MTC Source (Computer, or one of the four MIDI inputs).

MTC/Video
This mode is used for locking to a Blackburst or composite video signal while
using MTC (received from one of the
Studio 64 XTC’s MIDI inputs, or from a
software program) as the source address.

WORD CLOCK AND SUPER
CLOCK
The advent of digital audio has necessitated the need for an accurate, stable time
base.
Although a precise address source
(SMPTE) ensures that digital audio, from
either digital multitracks or hard disk
recorders, will begin playing at the correct time (location), that alone does not
guarantee a phase-lock relationship.
Because the speed of SMPTE sources will
sometimes vary or fluctuate, the material
on tape (or video) will likely drift out of
sync with digital audio events.
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This problem is alleviated when a stable
time base source is introduced into the
equation. Since the time base accurately
determines how long it takes to get from
one SMPTE location to another, digital
audio playback can then be slowed down
or sped up (without its pitch being noticeably affected) to ensure a true phase-lock
relationship.
The speed and pitch of audio playback is
controlled by the Studio 64 XTC’s Word
Clock and Super Clock outputs. Word
Clock can be sent to digital multitracks,
hard disk recorders, and DAT machines
(provided they accept Word Clock input).
Super Clock is Digidesign’s proprietary
sync format used with their professional
digital audio cards and interfaces.
NOTE: No matter which of the
Studio 64 XTC’s Sync Reference modes is
active, Word Clock and Super Clock are
always generated.

Sample Rate
The Studio 64 XTC’s Sample Rate setting
affects the Word Clock and Super Clock
generated. This setting must match the
sample rate with which your particular
audio hardware is configured.
The following choices are available for the
Studio 64 XTC’s sample rate setting:
•
•

44.1 kHz: The industry standard
sample rate for audio CDs.
48 kHz: The sample rate featured on
most professional DAT recorders. It
is also the default rate used by Alesis
ADATs.
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If you are unsure of the sample rate used
by your particular digital audio hardware,
please consult the manufacturer’s manual.
NOTE: Changing the Studio 64 XTC’s
sample rate setting does not automatically
set the rate for connected digital audio
hardware.
For information on adjusting the sample
rate of your digital audio hardware, consult
the manufacturer’s documentation.
NOTE: If using an Alesis ADAT or Tascam
DA-88, make sure the Sample Rate for the
Studio 64 XTC matches the rate used when
formatting your audio tapes.

Pull Up/Down Setting
Pull Up and Pull Down adjust the audio
sample rate to compensate for speed
changes that occur when transferring
between film and video.
It is very common when scoring for film
that a working video tape is created with a
process called Telecine. The Telecine process transfers the film, running at 24 fps,
to video tape running at 30 fps. Recording
at 30 fps ensures that no frames (or partial
frames) are lost in the transfer.
Unfortunately, playing this video on
NTSC video decks, which run at a speed
of 29.97 fps, results in a slowed-down playback. In addition, the tape’s audio also
plays slower—thereby making the pitch
slightly flat. This pulled-down audio is
often referred to as playing at “tape
speed” (as opposed to the original “film
speed”).
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When to Use Pull Up
If working with a video tape that plays at
“tape speed,” you can activate the
Studio 64 XTC’s Pull Up mode when
recording the tape’s audio with your digital audio hardware. After recording,
disable the Pull Up mode and the transferred audio will play back at “film speed.”
Once you have a scratch track at “film
speed,” you can record additional location
audio or dialog as needed.
When to Use Pull Down
If you have digital audio tracks at “film
speed” and you are syncing to a video
tape that’s playing at “tape speed,” the two
will drift out of sync and also play back at
different pitches.
To get around this problem, activate the
Studio 64 XTC’s Pull Down mode to
adjust the playback of your digital audio
hardware—thereby ensuring it is in sync
with the material playing at “tape speed.”

LOCK-UP TIME
When syncing to SMPTE or MTC, the
Studio 64 XTC waits about 5-10 seconds
for sync to stabilize before transmitting
MTC to your music software. This means
that there will be a delay between the time
the Studio 64 XTC receives time code and
the time your software begins playing.
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You may wish to allow adequate pre-roll
time (about 10 seconds) on your SMPTE
source so your software begins playing at
the desired time.
Unfortunately, this time it takes to lock-up
with external time code is necessary to
provide the most accurate sync between
digital audio devices.
NOTE: The 5-10 second lock-up time
applies only if Digital Phase Lock is
enabled for the Studio 64 XTC, see the following section for details.

There are, however, a few differences in
the way the Studio 64 XTC behaves when
Digital Phase Lock is disabled.
Specifically, if Digital Phase Lock is off
and the Sync Reference mode is set to
MTC or MTC/Video...
•
•

SMPTE is not generated and sent to
the SMPTE OUT jack.
For Mac users, MTC from your software is automatically sent to all MIDI
OUT ports, and to networked interfaces—when the MTC Source is
“Computer.”

Digital Phase Lock
If you are not using digital audio hardware
or an ADAT, you can disable Digital
Phase Lock for faster lock-up when syncing to SMPTE or MTC. This sync option
is stored in each user program and can be
disabled/enabled from the Program Edit
Window of your Mac or PC software.
When enabled, the Digital Phase Lock
option provides the most accurate sync
when using Word Clock and Super Clock
with digital audio hardware.
NOTE: The Studio 64 XTC still generates
Word/Super Clock when “Digital Phase
Lock” is disabled. In this mode, however,
audio sync is not as accurate.
IMPORTANT: Digital Phase Lock must be
enabled if you are controlling an Alesis
ADAT from the Studio 64 XTC’s ADAT
Sync port.
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STUDIO 64 XTC AND SMPTE
The Studio 64 XTC can either stripe or
sync to SMPTE. Whether the unit is generating or receiving SMPTE is indicated
by the status LEDs (when the SMPTE
function is chosen from the front panel).
A status LED, indicating the frame rate,
blinks slowly when the Studio 64 XTC is
generating SMPTE, or flashes rapidly
when receiving SMPTE.
IMPORTANT: In order for the
Studio 64 XTC to read SMPTE at its
SMPTE IN jack, the Sync Reference mode
must be set to either “SMPTE” or “SMPTE/
Video.”

How the Studio 64 XTC Stripes
SMPTE
The Studio 64 XTC can stripe SMPTE by
selecting the SMPTE preset program
with the PROGRAM button (see Front
Panel Operations (pg. 31)). The SMPTE
settings used are those stored in the current user program.
The Studio 64 XTC can also stripe
SMPTE from the SMPTE Window
(accessed from the Program Editor on
the PC, or OMS Setup on the Mac).
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While striping SMPTE, the Studio 64 XTC
can also transmit MTC to your computer
and/or MIDI outputs (based on the MTC
destinations specified in the current user
program).
NOTE: To facilitate setting levels, the
Studio 64 XTC emits a constant leader
tone when not striping. This leader tone
cannot be disabled.

How the Studio 64 XTC Reads
SMPTE
The SMPTE IN jack of the Studio 64 XTC
reads time code directly from a sync
source, such as a tape track. Upon reception of SMPTE, the Studio 64 XTC
automatically determines the frame rate
and after 5-10 seconds (typical lock-up
time with Digital Phase Lock on), the
appropriate status LED flashes rapidly.
Remember, this only takes place if the
Studio 64 XTC’s Sync Reference mode is
set to SMPTE or SMPTE/Video.
After initial lock-up, the Studio 64 XTC
communicates MTC to your computer
and MIDI outputs as specified in the current user program. In addition, time code
is regenerated and sent out the SMPTE
OUT jack.
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Reading 29.97 Non-Drop

Jam Sync

When receiving 29.97ND, the
Studio 64 XTC always detects it as 30ND.
It is not possible for hardware or software
to tell the difference between these two
SMPTE formats.

When the Studio 64 XTC reads incoming
SMPTE, it regenerates identical time
code to the SMPTE OUT jack. Regeneration allows re-striping of a damaged sync
track or “bouncing” from one sync track
to another.

For proper synchronization to 29.97ND,
make sure that the Studio 64 XTC’s current user program and your music
software are both set to this format.

SMPTE Freewheel
The Studio 64 XTC provides dropout protection on SMPTE input. This allows a
sequencer or other program to reliably
sync to SMPTE even when receiving corrupted time code (such as from tape
dropout). The Freewheel setting in the
SMPTE Window determines the number
of dropped frames (None, 2, 6, 10, 30, 60)
the Studio 64 XTC will tolerate. The
default Freewheel setting is 10 frames.
NOTE: Because the Studio 64 XTC cannot
distinguish between bad time code and time
code that has merely stopped, your MIDI
sequencer will continue to sync for a brief
time after the tape has stopped.

In the case of a severely damaged sync
track, or if you need to extend the length
of a sync track, the Studio 64 XTC can use
Jam Sync (a Freewheel setting in the
SMPTE Window). When Jam Sync is
enabled and the Studio 64 XTC locks onto
time code, it will regenerate SMPTE
indefinitely.

SMPTE CONNECTIONS
The Studio 64 XTC has SMPTE IN and
OUT jacks for direct connection to multitrack tape recorders, video decks, and
other equipment capable of receiving/
transmitting sync information. The sync
signals are output as line-level audio, so
special equipment is not required.
In general, SMPTE signals should bypass
mixing consoles, equalizers, and any
other signal processing equipment that
could add distortion to the signals and
affect synchronization. For connections,
use shielded audio cables with 1/4”
phone plug termination.
IMPORTANT: An optimum SMPTE signal
has a level between -10 db and -3 db, and
should not be processed by equalization,
compression/limiting, or noise reduction.
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SMPTE OUT Connection

SMPTE IN Connection

When striping a tape, connect the SMPTE
OUT jack of the Studio 64 XTC to the
audio input of the tape deck (either the
sync input or the last track).

When syncing to tape, connect the
SMPTE IN jack of the Studio 64 XTC to
the audio output of the tape deck’s
SMPTE track.

Studio 64 XTC

Studio 64 XTC

SMPTE in

SMPTE out

Multitrack

Track 8 input

Figure 11.1: Recording SMPTE to track 8 of
multitrack

NOTE: To facilitate setting levels, the
Studio 64 XTC emits a constant leader
tone when not striping.
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Multitrack

Track 8 output

Figure 11.2: Receiving SMPTE from multitrack

NOTE: After locking on to the incoming
SMPTE time code, the time code is then
regenerated and sent to the SMPTE OUT
jack.
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STRIPING/SYNCING TO TAPE
UNDER WINDOWS
Before beginning the following sections
you must install and configure the Windows driver for the Studio 64 XTC.

Striping with Program Editor (PC)
To stripe SMPTE from within the Program Editor on the PC:
a Make sure your tape deck is
connected to the Studio 64 XTC as
specified in SMPTE Connections
(pg. 56).
Always record to the first or last tape
track, this minimizes sync signal bleedthrough to adjacent tracks.

b Set record levels to between -10db
and -3db, according to your
equipment’s needs.
To facilitate setting levels, the
Studio 64 XTC emits a constant leader
tone when not striping.
If applicable, defeat noise reduction and
equalization for the sync track.

c Open the Program Editor by doubleclicking the 64xtc.exe icon. Then click
the SMPTE button to open the
SMPTE Window.

d Choose the desired SMPTE Format
by clicking on the appropriate radio
button.
If you’re using a multitrack recorder and
do not expect others to sync to your
tape, a format of “30 Non-Drop” will suffice. When working with a studio or other
third parties, consult them to determine
their requirements.

e Specify the SMPTE Start Time.
Unless you have a specific reason to use
a different time, you can safely choose
00:00:00:00.

f Choose any desired MTC
destination(s).
In most cases you will only send MTC to
the computer, which enables the Program Editor’s SMPTE Monitor to display
the generated time code.

g Place your tape deck in record mode
and start the tape rolling.

h After recording 3-4 seconds of just
the leader tone, click the Stripe
button.

i Allow sufficient time for the sync
track to be recorded. It is a good idea
to provide a minute or two of extra
margin so the sync track duration is
longer than the MIDI sequence.
To stop generating SMPTE, click Stop
or OK.

Figure 11.3: SMPTE Window for PC
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Syncing to Tape (PC)

h Start the tape rolling at the desired
location.

Although details will vary from one program to the next, use the following steps
to synchronize your Windows MIDI software to tape (consult your software’s user
manual for more info):
a Make sure connections between your
tape deck and the Studio 64 XTC are
as specified in SMPTE Connections
(pg. 56).

b Set tape playback levels to between

After 5-10 seconds (typical lock-up time
with Digital Phase Lock on), the
sequencer automatically begins playing
or recording from the tape’s location.
The sequencer tracks remain locked to
the material on tape until either the tape
or the software is stopped.

-10 db and -3 db.

STRIPING/SYNCING TO TAPE
ON THE MACINTOSH

If applicable, defeat any noise reduction
or equalization settings affecting the
sync track.

Before beginning the following sections,
OMS must be installed and configured.

c Set the Studio 64 XTC’s Sync
Reference mode to SMPTE.

Striping with OMS Setup (Mac)

If using Blackburst or video as the time
base source, set the Sync Reference
mode to “SMPTE/Video.”

To stripe SMPTE from within the
OMS Setup program on the Mac:

d Launch your MIDI sequencing
software. If you are using an existing
song file, open it; if recording a new
song, set it to the desired tempo.

e Set your sequencer’s sync source to
the 64XTC Sync Port.
If using an OMS application under Windows, such as Vision 2.5.1, the sync port
for the Studio 64 XTC is “Port 6” (as
defined in OMS Setup).

f Configure your sequencer to sync to
SMPTE (or MTC) and specify the
SMPTE format and offset time.

g Put your sequencer in play or record
mode.
Many programs display a “Waiting for
Sync” message.

Studio 64 XTC Manual

a Make sure your tape deck is
connected to the Studio 64 XTC as
specified in SMPTE Connections
(pg. 56).
Always record to the first or last tape
track, this minimizes sync signal bleedthrough to adjacent tracks.

b Set record levels to between -10db
and -3db, according to your
equipment’s needs
To facilitate setting levels, the
Studio 64 XTC emits a constant leader
tone when not striping.
If applicable, defeat noise reduction and
equalization for the sync track.
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c Launch the OMS Setup program and
choose Studio 64XTC>SMPTE to
open the SMPTE Window.

Syncing to Tape (Mac)
Although details will vary from one program to the next, use the following steps
to synchronize your Macintosh MIDI
sequencer to tape (consult your software’s user manual for more info):
a Make sure connections between your

Figure 11.4: SMPTE Window for Mac

The Studio 64XTC menu is only available when your current Studio Setup
contains a Studio 64 XTC.

d Choose the desired SMPTE Format
from the pop-up menu.
If you’re using a multitrack recorder and
do not expect others to sync to your
tape, a format of “30 Non-Drop” will suffice. When working with a studio or other
third parties, consult them to determine
their requirements.

e Specify the SMPTE Start Time.
Unless you have a specific reason to use
a different time, you can safely choose
00:00:00:00.

f Place your tape deck in record mode
and start the tape rolling.

g After recording 3-4 seconds of just
the leader tone, click Start Striping.

h Allow sufficient time for the sync
track to be recorded. It is a good idea
to provide a minute or two of extra
margin so the sync track duration is
longer than the MIDI sequence.

tape deck and the Studio 64 XTC are
as specified in SMPTE Connections
(pg. 56).

b Set tape playback levels to between
-10 db and -3 db.
If applicable, defeat any noise reduction
or equalization settings affecting the
sync track.

c Set the Studio 64 XTC’s Sync
Reference mode to SMPTE.
If using Blackburst or video as the time
base source, set the Sync Reference
mode to “SMPTE/Video.”

d Launch your MIDI sequencing
software. If using an existing song,
open it; if recording a new song, set it
to the desired tempo.

e Set your sequencer’s sync source to
the Studio 64XTC.

f Configure your sequencer to sync to
SMPTE (or MTC) and specify the
SMPTE format and offset time.

g Put your sequencer in play or record
mode.
Many programs display a “Waiting for
Sync” message.

To stop generating SMPTE, click Stop
Striping.
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h Start the tape rolling at the desired
location.
After 5-10 seconds (typical lock-up time
with Digital Phase Lock on), the
sequencer automatically begins playing
or recording from the tape’s location.
The sequencer tracks remain locked to
the material on tape until either the tape
or the software is stopped.

GENERATING SMPTE
The Studio 64 XTC is one of the few MIDI
interfaces that can actually generate
SMPTE time code while playing and
recording from your MIDI sequencing or
audio recording software.
Note that this is not the same as when
striping a tape with SMPTE—though in
both instances time code is actually sent
to the Studio 64 XTC’s SMPTE OUT jack.
When “generating” SMPTE, the generated timecode is sent along with (and in
sync with) the Word/Super Clock sent to
the audio devices, and the MTC sent to
the computer.
This is very useful for transmitting
SMPTE time code to external devices like
automated mixers and digital recorders
that “chase lock” SMPTE time code.

Studio 64 XTC Manual

NOTE: Regardless of the Studio 64 XTC’s
Sync Reference mode, the unit almost
always generates SMPTE time code when it
is sending sync information.
However, if the Sync Reference mode is
MTC or MTC/Video and “Digital Phase
Lock” is off, SMPTE time code is not
generated.

MIDI TIME CODE
In addition to syncing to SMPTE time
code via the SMPTE IN jack, the
Studio 64 XTC can also sync to MTC. In
this scenario the Studio 64 XTC’s Sync
Reference mode must be set to MTC or
MTC/Video.
The MTC Source, which is specified in
the current user program, can be one of
the four MIDI INs, or the Computer (if
receiving MTC from a software
application).

Generating MTC
Regardless of the Studio 64 XTC’s Sync
Reference mode, the interface always generates MTC when generating sync
information.
In most cases, the destination for the
MTC will be the “Computer,” as when
using software for MIDI sequencing or
digital audio recording.
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However, the generated MTC can also be
sent to any of the four MIDI OUTs as
determined by the current user program
for the Studio 64 XTC.
On the PC, MTC destination ports are
specified in the Program Editor’s SMPTE
Window.

Sending MTC from MIDI Software (with
Digital Phase Lock off)
If you wish to send MTC from a MIDI
software application and you are not using
Digital Phase Lock (i.e. you are not using
digital audio hardware or an ADAT), the
Studio 64 XTC can automatically direct
the MTC to all MIDI OUTs.
To do this, set the Sync Reference mode
for the Studio 64 XTC to MTC with the
MTC Source set to Computer (remember, make sure that Digital Phase Lock is
disabled).

Figure 11.5: SMPTE Window (PC), MTC routed to
Computer and Port 2

On the Mac, MTC destination ports are
specified in the Connection Grid.

Then in your MIDI application direct the
MTC to the Studio 64 XTC (on the PC,
specify the destination as the “64XTC
Broadcast Port”).
The end result of this scenario is that
MTC from the software is sent to all MIDI
OUTs (and to any Networked interfaces).
NOTE: If you don’t want MTC sent to all
MIDI OUTs, use the Connection Grid in
the Program Edit Window to mute MTC for
each desired OUT.

Figure 11.6: Connection Grid (Mac), MTC routed to
Computer and Port 2
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The Studio 64 XTC turns your personal
computer into a remote control center for
Alesis ADATs and MIDI Machine Control
(MMC) devices.

WORKING WITH ALESIS ADATS
Slaving Alesis ADATs from the
Studio 64 XTC requires very little in the
way of setup and configuration.

ABOUT MIDI MACHINE
CONTROL
With the Studio 64 XTC and the appropriate MIDI software, your computer can
use MMC commands to control the transports of compatible recording devices.
MMC instructs your recording device(s)
to play, record, pause, stop, fast-forward,
rewind, and even record-enable tracks.
This makes it very easy to integrate external multitracks and hard disk recorders
with computer sequencing or digital
recording software—thereby using a
single transport to control the playback
and recording of many devices.

Studio 64 XTC

ADAT Sync

Sync In

Alesis ADAT, Device 1

Additional ADATs, daisy-chained

Figure 12.1: Controlling one or more ADATs from the
Studio 64 XTC

All the information necessary for controlling ADATs is communicated from the
Studio 64 XTC’s ADAT Sync port. What’s
more, additional ADATS can be daisychained and the Studio 64 XTC will easily
control them as well.

Studio 64 XTC Manual
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ADAT ID and Offset
Stored with each Studio 64 XTC user program are ADAT settings for ID and
offset. These two settings cannot be
edited from the Studio 64 XTC’s front
panel; if you wish to change them you
must therefore use the included PC or
Macintosh software.

Figure 12.2: Sync settings from Program Editor (PC)

Figure 12.3: Sync settings from OMS Setup (Mac)

ADAT ID
When an ADAT is connected to the
Studio 64 XTC, its ID is automatically
configured to the ID setting stored in the
current user program. If more than one
ADAT is connected, each unit’s ID is configured incrementally (for instance, first
ADAT set to “0,” next ADAT set to “1”).
It is important that the ADAT ID setting in
your user programs match the ID specified in your sequencing software. If you
are using OMS, make sure the device
defined as your ADAT is also set to that
ID.
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IMPORTANT: The ID numbering scheme
for the Alesis ADAT is off by one. For
instance, if your Studio 64 XTC user program is set to “0,” the front panel of your
ADAT will actually display “1.”
ADAT Offset
The ADAT offset only affects location
information sent to the ADATs (from the
Studio 64 XTC’s ADAT Sync port). This
allows you to have the ADAT play any
location on the tape relative to incoming
time code. The offset is needed because
ADAT tapes only provide about 40
minutes of play time, while time code
could come in at any time within a 24 hour
range.
For instance, suppose you were trying to
sync to something on video that began at
02:30:00:00, and you wanted to start 10
minutes into the ADAT tape. In this example, you would specify an ADAT Offset of
negative (-) 02:20:00:00 (2 hours, 30 minutes minus 10 minutes).
NOTE: If the incoming time code is later
than the corresponding location on the
ADAT tape, a negative offset must be
specified.
If, on the other hand, the time code source
started at 00:01:00:00 and you wanted to
begin at 5 minutes in to your ADAT tape,
you would specify an ADAT Offset of positive (+) 00:04:00:00.
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MMC Setup for ADATs
To control one or more ADATs via MMC
with your Studio 64 XTC:
a Turn off your Studio 64 XTC and any
ADATs you wish to slave.

b Connect the Studio 64 XTC’s ADAT
Sync port to the “Sync In” of your
ADAT.

c If you have additional ADATs, connect

Also, make sure the user program has
the ADAT routed to and from your computer in the Connection Grid; and
choose the desired SMPTE Frame Rate
in the SMPTE Window.

g From either your PC or Macintosh,
save and store the user program in
your Studio 64 XTC.

h If using an OMS application, add a
device to your current Studio Setup
and assign its port number to 5.

the Sync Out of the first ADAT to the
Sync In of the second ADAT—and so
forth.

d Turn on the Studio 64 XTC and
ADATs.

e From the front panel of the
Studio 64 XTC, use the PROGRAM
button to call up the Sample Rate
function.
Check the status of the LED for the
ADAT on the Studio 64 XTC’s front
panel.
If lit, the Studio 64 XTC is connected
successfully to the first ADAT. If not lit,
turn everything off and check
connections.

f Using either the Program Editor (PC)

Add a device
assigned to
port 5.

In addition, make sure the device is set
to send and receive both MTC and
MMC. And make sure the OMS Device
ID (in this example, “0”) matches that
contained in the current Studio 64 XTC
user program.

or OMS Setup (Mac), configure and
save a Studio 64 XTC user program
with the following settings.
Sync Reference (Source): Internal
Sample Rate: 48k (default for ADAT)
MTC Source: Computer
Digital Phase Lock: On
ADAT Online: On
ADAT ID: 0
In addition, see ADAT ID and Offset
(pg. 64) for details on setting an appropriate ADAT Offset.

Studio 64 XTC Manual

Figure 12.4: OMS Device Info for Alesis ADAT
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If using multiple ADATs, additional units
should appear in OMS as daisy-chained
devices on port 5. See Figure 12.5.

Second ADAT daisychained to first ADAT
on port 5

Taking the ADAT Offline
The ADAT Online option lets you specify
whether the Studio 64 XTC communicates with a connected ADAT. If you take
the ADAT “offline,” time code and transport commands are not sent to the ADAT
Sync port. And, since the Studio 64 XTC
doesn’t have to wait for the ADAT to
locate before it begins generating sync,
this speeds up the time it takes to lock up
with your sequencing software.

Figure 12.5: Multiple ADATs in Studio Setup

In addition, each successive ADAT in
OMS must be set to an ID one greater
than the previous. If, for instance, the ID
of the ADAT connected directly to the
Studio 64 XTC is defined as “0,” the
second ADAT should be specified as “1.”

NOTE: The current Studio 64 XTC user
program sets the ID for the ADAT connected directly to the Studio 64 XTC.
See ADAT ID and Offset (pg. 64).

i Lastly, set up your sequencing
software for MMC control of the ADAT
with the Studio 64 XTC as the sync
source.
If using an OMS-compatible application,
simply select the ADAT (the device in
your Studio Setup connected to port 5)
as your MMC device.
If using Windows, make sure your
application directs MMC commands to
the 64XTC ADAT Out Port.
In some MMC applications you may
have to specify the type of MMC device
you are using, its ID, SMPTE offset, and
how many tracks it has. Consult your
software’s user manual for details.
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Using either the Program Editor under
Windows (see Chapter 8, page 33) or the
OMS Setup application on the Mac (see
Chapter 9, page 39), you can specify for
each user program whether the ADAT is
online or not.
You can also temporarily take the ADAT
offline from the front panel of the
Studio 64 XTC:
a Turn on the Studio 64 XTC and ADAT.
b Using the PROGRAM button, call up
the Sample Rate sync function.
The LED for the selected sample rate is
lit, along with the ADAT LED (indicating
it's detected and online).

c Press the SYNC button repeatedly
until the ADAT LED is selected (it
should blink rapidly).
After a few seconds, the sample rate
LED will again become lit, and the ADAT
LED will then blink slowly (indicating it's
offline).
Repeat the previous step to place the
ADAT back online.
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To control the Tascam DA-88 via MMC
with your Studio 64 XTC:

CONTROLLING OTHER MMC
DEVICES
The Studio 64 XTC can also control a variety of MMC devices via its MIDI ports.
Following is a configuration example for
the Tascam DA-88.

Using a Tascam DA-88
For the Studio 64 XTC to control the
Tascam DA-88 via MMC, you will need
the SY-88 sync card option from Tascam.
Once installed, the SY-88 provides I/O for
MTC, MMC, and Word Clock.
Studio 64 XTC

MIDI in

MIDI out

a Turn off the Studio 64 XTC and
Tascam DA-88.

b Install the SY-88 sync card as
specified by your Tascam
documentation.
Set dip switch #2 (located on the left side
of the SY-88 expansion card) to the UP
position. Set dip switch #6 to the DOWN
position. Consult your Tascam
documentation for details.

c Connect the MIDI output of the SY-88
card to the Studio 64 XTC’s MIDI IN
port number 1. Connect the MIDI input
of the SY-88 sync card to the
Studio 64 XTC’s MIDI OUT port
number 1.

d Connect the Word Clock Out of the
Studio 64 XTC to the Word Clock
input of the Tascam SY-88 sync card.

MIDI out

MIDI in

Tascam DA-88 with
SY-88 Sync Card

Figure 12.6: Controlling Tascam DA-88 via MMC

If there are no other digital recording
devices involved in this setup (such as
hard disk recorders), there is no need to
make this connection.

e Turn on the Studio 64 XTC and DA-88.
f Verify that the DA-88’s Device ID is set
to 1 (the value used in this example).
In addition, make sure the DA-88 is in
Timecode controlled mode, and
that “timecode out” is set to
Absolute.
To switch the DA-88 to timecode controlled mode, hold either the down or up
arrow key and press the other when the
display is in its ABS time mode (ABS
LED lit). Again, consult your Tascam
documentation for details.

Studio 64 XTC Manual
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g Using either the Program Editor (PC)

i Lastly, set up your sequencing

or OMS Setup (Mac), configure and
save a Studio 64 XTC user program
with the following settings.

software for MMC control of the DA-88
with the Studio 64 XTC as the sync
source.

Sync Reference (Source): MTC
Sample Rate: 48k (default for DA-88)
MTC Source: Port 1
Digital Phase Lock: On

If using an OMS-compatible application,
simply select the DA-88 as your MMC
device.

Also, choose the desired SMPTE Frame
Rate in the SMPTE Window.

NOTE: If no other audio devices are
involved in this scenario, you can disable
Digital Phase Lock for faster lock-up
times.

h If using an OMS application to control
the DA-88, configure OMS
accordingly.

If using Windows, make sure your
application directs MMC commands to
the 64XTC MIDI Out Port that corresponds to the DA-88/SY-88.
In some MMC applications you may
have to specify the type of MMC device
you are using, it’s ID, SMPTE offset, and
how many tracks it has. Consult your
software’s user manual for details.

Add a device to your current Studio
Setup with the DA-88 connected port 1
of the Studio 64 XTC.

Figure 12.7: OMS Device Info for DA-88

The device defined as the DA-88 in OMS
should be set to an ID of “0,” which is
one less than the actual unit (unfortunately, the ID numbering scheme on the
DA-88 is off by one).
Also, make sure to set the device to
receive and send both MTC and MMC.
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This chapter explores some of the real
world examples of synchronizing various
audio hardware. Although every possible
scenario is not covered, hopefully the following examples will provide enough
information for most users.

USING WORD CLOCK AND
SUPER CLOCK
Following are some examples using Word
Clock and Super Clock with digital audio
hardware.

Address source: Analog Multitrack
Time Base source: Analog Multitrack
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE
This scenario involves syncing to SMPTE
from an analog multitrack while sending
Super Clock to Digidesign’s Pro Tools
hardware. Any fluctuations in the speed of
the time code entering the Studio 64 XTC
are compensated for in the generated
Super Clock—thereby adjusting the
sample rate playback of the Pro Tool’s
hardware.
a Turn off your Studio 64 XTC,

Analog Multitrack and Pro Tools

multitrack recorder, and Digidesign
audio interface.

b Connect the audio out of the

Studio 64 XTC

multitrack’s SMPTE track to the
SMPTE IN jack of the Studio 64 XTC.
SMPTE in

c Connect the Studio 64 XTC’s Super

Super Clock out

Slave Clock in
SMPTE Track out

Digidesign I/O

Clock port to the “Slave Clock In” of
your Digidesign audio interface.

d Turn on your equipment.
e Using either the Program Editor on
the PC, or OMS Setup on the
Macintosh, edit and store a

Analog Multitrack

Figure 13.1: Syncing analog multitrack and
Pro Tools

Studio 64 XTC Manual
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Studio 64 XTC user program with the
Sync Reference mode set to SMPTE.
Also, make sure to specify the desired
SMPTE format and sample rate for the
user program. And, Digital Phase lock
must be enabled.

f Configure your digital recording
software to sync to MTC with the
Studio 64 XTC as the sync source.
In addition, configure any necessary settings for SMPTE frame rate and sample
rate for the audio hardware.
Consult the appropriate manufacturer’s
manuals as needed.

This example illustrates controlling the
Tascam DA-88 (with SY-88 sync card) via
MMC. In addition, Word Clock is sent to
the DA-88 and Super Clock to Digidesign’s Session 8 PC, which allows the
digital audio playback of both devices to
be in sync.
In this example, MTC from the DA-88 is
the source for both address and time
base.
a Turn off your Studio 64 XTC, DA-88,
and Digidesign audio interface.

b Connect the Super Clock Out of the
Studio 64 XTC to the “Slave Clock In”
of the Digidesign audio interface.

Session 8 PC and DA-88

c Connect the Word Clock Out of the
Studio 64 XTC to the Word Clock
input of the Tascam SY-88 sync card.

Digidesign I/O

d Connect the MIDI output of the SY-88

Slave Clock in

Studio 64 XTC

Super Clock out

Word Clock out
MIDI in/out
Word Clock in

card to one of the Studio 64 XTC’s
MIDI inputs. Connect the MIDI input of
the SY-88 sync card to the MIDI output
of the Studio 64 XTC.
Make sure to use the same
Studio 64 XTC port number for each
MIDI connection.

e Turn on your equipment.
f Make sure the DA-88, Studio 64 XTC,
Tascam DA-88 with
SY-88 Sync Card

Figure 13.2: Syncing Tascam DA-88 and
Session 8 PC

Address source: DA-88
Time Base source: DA-88
Word Clock destination: DA-88
Super Clock destination: Session 8
Sync Ref mode for XTC: MTC
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and necessary software are
configured appropriately for MMC
control.
For details, see Using a Tascam DA-88
(pg. 67).

g Using either the Program Editor on
the PC, or OMS Setup on the
Macintosh, edit and store a
Studio 64 XTC user program with the
Sync Reference mode set to MTC.
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Also, make sure to specify the desired
SMPTE format and sample rate for the
user program. And, Digital Phase Lock
must be enabled.

h Configure your digital recording
software to control the DA-88 via
MMC with the Studio 64 XTC as the
sync source.
In addition, configure any necessary settings for SMPTE frame rate and sample
rate for the audio hardware.
Consult the appropriate manufacturer’s
manuals as needed.

USING BLACKBURST/VIDEO
SYNC
Following are some examples syncing
digital audio hardware to Blackburst and
composite video signals.

Address source: Video Deck
Time Base source: Video Deck
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video
This scenario involves syncing Digidesign
Pro Tools hardware to a video deck. The
video deck, in this example, acts as both
the address and time base source. The
Studio 64 XTC generates Super Clock
(sent to the Pro Tools hardware) based on
the composite video signal and SMPTE
from the video deck—thereby ensuring
the video frames are in sync with the digital audio playback.
a Turn off your Studio 64 XTC,
Digidesign audio interface, and video
deck.

b Connect the video out jack of the
video deck to the Studio 64 XTC’s
Blackburst/Video In jack.

c Connect the audio out of the video

Video Deck and Pro Tools
Digidesign I/O

deck (containing the SMPTE time
code signal) to the SMPTE IN of the
Studio 64 XTC.

d Connect the Studio 64 XTC’s Super
Clock Out to the “Slave Clock In” of
your Digidesign audio interface.

Slave Clock in

Studio 64 XTC

Super Clock out

SMPTE in

Video in

SMPTE
Track out

Video out

Video Deck

Figure 13.3: Syncing Pro Tools to a video deck
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e Turn on your equipment.
f Using either the Program Editor on
the PC, or OMS Setup on the
Macintosh, edit and store a
Studio 64 XTC user program with the
Sync Reference mode set to SMPTE/
Video.
Also, make sure to specify the desired
SMPTE format and sample rate for the
user program. And, Digital Phase Lock
must be enabled.
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g Configure your digital recording
software to sync to MTC with the
Studio 64 XTC as the sync source.
In addition, configure any necessary settings for SMPTE frame rate and sample
rate for the audio hardware.
Consult the appropriate manufacturer’s
manuals as needed.

Blackburst, Video Deck, and
DA-88

playback speed of the professional video
deck (SMPTE source). As a result, the
Studio 64 XTC generates Word Clock and
SMPTE that keep the DA-88 in sync with
the video.
NOTE: This example assumes your professional video deck supports receiving a
Blackburst (house sync) signal.
a Turn off your Studio 64 XTC, Tascam
DA-88, video deck, and Blackburst
generator.

b Connect the audio out of the video

Tascam DA-88 with
SY-88 Sync Card

deck (containing the SMPTE time
code signal) to the SMPTE IN of the
Studio 64 XTC.

c Connect the output of the Blackburst
SMPTE out

Word Clock out

SMPTE in

Studio 64 XTC

Blackburst in

generator to the Studio 64 XTC’s
Blackburst/Video In jack.
In addition, connect the Blackburst generator to the video deck and configure as
specified by the manufacturer.

d Connect the Word Clock Out of the
Video Deck

Studio 64 XTC to the Word Clock
input of the Tascam SY-88 sync card.

e Connect the SMPTE OUT of the
Figure 13.4: Syncing Tascam DA-88 to Blackburst
generator and video deck

Address source: Video Deck
Time Base source: Blackburst
Word Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video
This example involves syncing a Tascam
DA-88 (with SY-88 sync card) to a Blackburst generator. The Blackburst box
provides the time base to the
Studio 64 XTC while also controlling the
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Studio 64 XTC to the SMPTE input of
the SY-88 sync card.
Configure the DA-88/SY-88 to chase
SMPTE time code. Consult your Tascam
documentation for details.

NOTE: This example does not provide
for MMC control of the DA-88.

f Turn on your equipment.
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g Using either the Program Editor on
the PC, or OMS Setup on the
Macintosh, edit and store a
Studio 64 XTC user program with the
Sync Reference mode set to SMPTE/
Video.
Also, make sure to specify the desired
SMPTE format and sample rate for the
user program. And, Digital Phase Lock
must be enabled.

h Configure your digital recording
software to sync to MTC with the
Studio 64 XTC as the sync source.
In addition, configure any necessary settings for SMPTE frame rate and sample
rate for the audio hardware.
Consult the appropriate manufacturer’s
manuals as needed.

This scenario syncs Digidesign Pro Tools
and the Alesis ADAT to a Blackburst signal. Again, as in the previous example, the
Blackburst box provides the time base to
the Studio 64 XTC while controlling the
playback speed of the video deck.
The Studio 64 XTC generates Super
Clock (sent to the Pro Tools hardware)
that keeps its digital audio playback in
sync with the video and ADAT.
NOTE: This example assumes your professional video deck supports receiving a
Blackburst (house sync) signal.
a Turn off your Studio 64 XTC, Alesis

Blackburst, Video Deck,
Pro Tools, and ADAT

ADAT, Digidesign audio interface,
video deck, and Blackburst generator.

b Connect the audio out of the video

Alesis ADAT

Digidesign I/O
Sync In

ADAT Sync

Super Clock out

Blackburst in

deck (containing the SMPTE time
code signal) to the SMPTE IN of the
Studio 64 XTC.

c Connect the output of the Blackburst

Slave Clock in

SMPTE in

Address source: Video Deck
Time Base source: Blackburst
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video

Studio 64 XTC

Video Deck

generator to the Studio 64 XTC’s
Blackburst/Video In jack.
In addition, connect the Blackburst generator to the video deck and configure as
specified by the manufacturer.

d Connect the Studio 64 XTC’s Super
Clock Out to the “Slave Clock In” of
your Digidesign audio interface.

Figure 13.5: Syncing ADAT and Pro Tools to
Blackburst generator and video deck
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e Connect the Studio 64 XTC’s ADAT
Sync port to the “Sync In” of your
ADAT.
If you have additional ADATs, connect
the Sync Out of the first ADAT to the
Sync In of the second ADAT—and so
forth.
For details on configuring the
Studio 64 XTC for use with an ADAT,
see Working with Alesis ADATs (pg. 63).

NOTE: This example does not provide
MMC control of the ADAT.

f Turn on your equipment.
g Using either the Program Editor on
the PC, or OMS Setup on the
Macintosh, edit and store a
Studio 64 XTC user program with the
Sync Reference mode set to SMPTE/
Video.
Also, make sure to specify the desired
SMPTE format and sample rate for the
user program. And, Digital Phase Lock
must be enabled.

NOTE: Since the ADAT will chase
SMPTE from the Studio 64 XTC in this
scenario, enter an ADAT offset for the
user program, if necessary. See
ADAT ID and Offset (pg. 64) for details.

h Configure your digital recording
software to sync to MTC with the
Studio 64 XTC specified as the sync
source.
In addition, configure any necessary settings for SMPTE frame rate and sample
rate for the audio hardware.
Consult the appropriate manufacturer’s
manuals as needed.
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APPENDIX A: Troubleshooting

WHERE TO START
Setting up a MIDI system involves a variety of components, each of which must be
working properly before you can successfully get down to making music. When
encountering problems, you should focus
on each system component separately;
then focus on the relationships between
the various components.

If you have checked the items just mentioned and have verified your computer
connection, see the following sections on
MIDI Input/Output Problems (pg. 77) and
Sync Problems (pg. 80).

MIDI INPUT/OUTPUT
PROBLEMS
Following are some common MIDI input
and output problems:

Verifying Connections
If you are having trouble with using the
Studio 64 XTC as a MIDI interface, you
should first test the unit’s connection to
your computer.
If using a PC, see Verifying PC Connections with XTCDIAG (pg. 26); for
Macintosh, see Verifying Mac Connections
with Test Studio (pg. 26).

General Operational Problems
While it is possible you may have a defective Studio 64 XTC, it is rather unlikely.
Most difficulties encountered are operational problems and likely related to
connections, power usage, software setup,
or user program settings.
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When using the Studio 64 XTC as a
stand-alone patchbay, no MIDI is routed.
• Monitor the Studio 64 XTC’s MIDI
input/output LEDs to see if data is
routed as expected.
• The Studio 64 XTC user programs
may not contain the desired routings.
Use the Program Editor on the PC, or
OMS Setup on the Mac to make the
necessary changes.
• Check MIDI connections. Make sure
your instrument’s MIDI OUTs are
connected to the Studio 64’s MIDI
INs, and vice-versa.
• Check that your instruments are set
to receive MIDI on the desired
channels.
• Try using the ALL preset program,
which routes all inputs to all outputs.

77

PART 4: Appendices

No MIDI data is received/recorded.
• Verify the Studio 64 XTC is powered
on and securely connected to your
computer; Windows users, make sure
the driver is installed; Mac users,
make sure OMS is configured
correctly.
• Check if a red MIDI input LED is
blinking, indicating data received.
• Verify your instrument’s MIDI OUT
is connected to the appropriate
Studio 64 XTC MIDI IN.
• Is your MIDI software set to receive
MIDI from the correct port number
(instrument)?
• Is your instrument configured to send
MIDI?
Certain types of MIDI data or specific
channels are not recorded/received.
• Some MIDI sequencers have record
filters. Make sure your sequencer is
set to receive (record) the desired
MIDI messages.
• Check that the current Studio 64 XTC
user program is not filtering the
desired MIDI messages or channels.
Notes are doubled (or distorted) when
playing from a keyboard into software.
• If your software’s MIDI thru (or
echo) is enabled, make sure your keyboard’s “local mode” is disabled.
• MIDI sequencing software generally
takes care of MIDI routing. Therefore, you should use a Studio 64 XTC
user program that contains no routings (such as the default factory user
program 1).
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No MIDI output.
• Verify the Studio 64 XTC is powered
on and securely connected to your
computer; Windows users, make sure
the driver is installed; Mac users,
make sure OMS is configured
correctly.
• Are the tracks in your MIDI software
assigned to the correct port number
(instrument) and channel?
• Is your instrument configured to
receive MIDI and is it set to the correct channel(s)?
• Check if the correct green MIDI
output LED is blinking, indicating
data sent.
• Verify your instrument’s MIDI IN is
connected to the appropriate
Studio 64 XTC MIDI OUT.
Certain types of MIDI data or specific
channels are not output.
• Check that the current Studio 64 XTC
user program is not filtering the
desired MIDI messages or channels.
• Make sure your instrument is set to
receive the desired MIDI messages
and is set to receive on the appropriate channel(s).
Sysex is not successfully sent to an
instrument.
• Make sure there are no MIDI data
loops present. Try using a
Studio 64 XTC user program with no
routings present (like the default factory user program 1).
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•

•
•

•

•

Make sure the instrument is set to
receive sysex; some instruments
require Memory Protect to be OFF.
Make sure the current Studio 64 XTC
user program is not filtering sysex.
Some instruments have a MIDI port
that acts as both MIDI OUT and
THRU—make sure it is configured as
an OUT.
Some Editor/Librarian programs
need handshaking communication
and thus require both MIDI ports
(OUT and IN) of an instrument to be
connected. And if both ports of a
MIDI instrument are connected,
always use the same Studio 64 XTC
port number.
If using an Editor/Librarian program,
verify the instrument’s device ID
matches the software settings.

MIDI instrument displays “MIDI Data
Error” or “MIDI Buffer Full.”
• Check for bad MIDI cables.
• Make sure there no MIDI data loops
present. Try using a Studio 64 XTC
user program that contains no routings (like the default factory user
program 1).
• If problems persist with user programs, try restoring the
Studio 64 XTC to its default state, see
Initializing User Programs (pg. 32).
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Tracks play back with wrong
instruments, channels, or patches.
• Monitor green MIDI output LEDs to
see if tracks are sent to the desired
OUT.
• Make sure tracks are assigned to the
correct port number (instrument).
• Your instruments’ MIDI receive channel(s) may not agree with the MIDI
data sent. Check channel settings in
your software as well as the channel
bump settings for the current
Studio 64 XTC user program.
Some MIDI input/output LEDs glow
steadily and won’t quit.
• Try selecting the PANIC preset program to clear all sounding notes.
• You may have a MIDI loop. Disconnect and then reconnect MIDI cables
for the affected port(s) to break the
loop. Then, make sure that MIDI data
output from the Studio 64 XTC cannot
make its way back into the
Studio 64 XTC.
• If problems persist with user programs, try restoring the
Studio 64 XTC to its default state, see
Initializing User Programs (pg. 32).
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SYNC PROBLEMS
Below are some common sync and
SMPTE problems:
ADAT does not respond to sequencing
software.
• Call up the Studio 64 XTC’s Sample
Rate function mode from the front
panel. If the ADAT status LED is lit,
your connection is correct.
• Verify that the Studio XTC’s current
user program is configured correctly
for controlling the ADAT; also check
that software is set up appropriately.
See Working with Alesis ADATs
(pg. 63) for more details.
The Studio 64 XTC SMPTE LED
indicates no SMPTE signal, or an erratic
signal.
• Check that SMPTE connections are
secure.
• Make sure the sync track is not processed by equalization, compression/
limiting, or noise reduction. Avoid
routing SMPTE signals through a
mixer.
• Make you are receiving an optimal
SMPTE signal, which should be in
the range of -10 db to -3 db.
The Studio 64 XTC responds to SMPTE
time code but sequencer doesn’t.
• Verify the software’s sync source is
assigned to the Studio 64 XTC.
• Make sure the sequencer is set to use
the correct SMPTE format and offset
time.
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•

•

Verify the sequencer is set to sync to
SMPTE and is in play or record
mode.
See if time code is received in the
SMPTE Window, which would indicate correct configuration of
Windows driver on the PC, and OMS
on the Mac.

Sequencer keeps running even after
stopping tape.
This is normal when using SMPTE freewheel. The Studio 64 XTC cannot detect
the difference between a stopped tape and
bad sync data. To reduce this effect,
adjust the freewheel setting in the
SMPTE Window.
A tone emanates from SMPTE OUT jack
when not striping.
This is normal. The Studio 64 XTC’s
SMPTE OUT jack outputs a constant
leader tone to facilitate setting record
levels.
The SMPTE Window displays 30-frame
Non-Drop when reading 29.97 Non-Drop.
MIDI Time Code does not differentiate
between these two SMPTE formats. It is
therefore important to set your sequencing software to the frame rate that
matches the tape’s sync track.
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SMPTE sync problems with 29.97 Drop
Frame, but not other formats.
• Verify that the tape indeed has 29.97
Drop-Frame time code, and that your
software is set for this format.
• Make sure your sequencer supports
this particular SMPTE format.
Erratic timing or jumbled notes when
playing from the start of sequence.
The sequencer’s offset time should be at
least three seconds after the SMPTE start
time. This is to ensure adequate time for
tape speed to stabilize and therefore provide accurate sync lock-up with your
sequencer.
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APPENDIX B: Networking

The Studio 64 XTC’s Network port connects to an Opcode Studio 4, thereby
allowing both interfaces to share the same
computer port. As of the printing of this
manual, networking is only supported on
the Macintosh.

Channelizing, and Muting” options are
not accessible. However, it is still possible
to create OMS Studio Patches containing
MIDI routings (and processing) between
devices connected to either interface.

NOTE: You cannot use the Network port to
connect two Studio 64 XTCs.

Macintosh
Modem or
Printer Port

NOTE: In addition to the Studio 4, future
Opcode interfaces may also be compatible
with the Studio 64 XTC’s Network port.

NETWORKING A STUDIO 4
(MAC)

Studio 64 XTC

Studio 4
MIDI OUT

SMPTE
PORT B
IN

When networking an Opcode Studio 4 to
the Studio 64 XTC, there are a few important things to keep in mind. Once
networked, the Studio 4 is primarily used
as additional MIDI input and output ports
for the Studio 64 XTC. In fact, MIDI
devices connected to the Studio 4 appear
in OMS as Studio 64 XTC devices on
ports 9-16 (see Figure B.2 on page 80).
In addition, once the Studio 4 is networked some of its advanced capabilities
are no longer available. For instance, the
Studio 4 menu is no longer available in
OMS Setup and therefore “MIDI Routing,
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Figure B.1: Studio 64 XTC and Studio 4 networked
to Macintosh

To network an Opcode Studio 4 to the
Studio 64 XTC:
a Turn off the Studio 64 XTC, Studio 4,
and Macintosh.

b Connect the Studio 64 XTC’s Mac port
to the Mac’s modem or printer port.
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c Connect the Studio 64 XTC’s Network
port to the Studio 4’s B Port.
Make sure to connect to the Studio 4’s
computer B port (the one with the little
picture of the Mac Plus) and not the Thru
port.

Make sure to enable (check) each undefined port you wish to use. Ports 1-4
correspond to Studio 64 XTC devices,
port 5 is the ADAT port, and ports 9-16
correspond to Studio 4 devices.

d Configure the Studio 4’s front panel
switches.
Set the 1mHz/Fast switch to Fast, the
1-8/9-16 switch to 9-16, and the
MIDI/B-Thru switch to MIDI.

Ports 1-5 are
Studio 64 XTC
devices.

e Turn on your equipment.
f Launch OMS Setup and choose
File>New Studio Setup.
When prompted, specify the Mac port
(modem or printer) to which the
Studio 64 XTC is connected. Then click
Search for OMS to search for connected interfaces.

Ports 9-16
are Studio 4
devices.

g In the resulting dialog, OMS displays
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the detected Studio 64 XTC. Next click
OK to search for connected MIDI
instruments.

Figure B.2: Studio Setup containing networked
Studio 64 XTC and Studio 4

Devices successfully detected by OMS
appear in the following dialog. If a device
was not detected or if nothing is connected to a particular port, a keyboard
icon with a red question mark is
displayed.

IMPORTANT: MIDI devices connected
to the Studio 4 actually appear in OMS
as Studio 64 XTC devices on ports 9-16.
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WINDOWS DRIVER
INSTALLATION
To use the Studio 64 XTC with Windows
applications, the supplied driver must be
installed. The easiest way to install the
driver for the Studio 64 XTC is to run the
Setup program, located on the PC floppy
disk included with your package. Additionally, the driver can be installed from
within Windows 95 or Windows 3.1.

Driver Installation under
Windows 95
a From the Windows 95 taskbar, choose
Start>Settings>Control Panel.

b Double-click the Add New Hardware
control panel, and in the following
dialog click Next.

NOTE: The easiest way to install the driver
for the Studio 64 XTC is by running the
Setup program on your PC disk.
IMPORTANT: Before attempting to install
the Studio 64 XTC driver (from either the
Setup program, or from the Windows control panel), make sure the unit is connected
to your PC and powered on.
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In the resulting dialog, click Next.

c When windows offers to search for
hardware, click No and then Next.
Windows asks what type of hardware
you are installing.
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d Select Sound, Video and Game
Controllers as the hardware you’d
like to install and click Next.

e When prompted with the list of
hardware drivers provided by
Windows 95, click Have Disk.

f As prompted, insert the
Studio 64 XTC PC disk and specify
the letter of your floppy drive (usually
either A:\ or B:\). Click OK.
Windows accesses the disk and after a
brief delay, a list of drivers on the disk
appears.

g Select the Studio64XTC entry and
click OK.

i In the driver setup dialog, enter the
COM port and IRQ for your
Studio 64 XTC connection. Click OK.
Generally, COM1 and COM3 default to
IRQ4, while COM2 and COM4 default to
IRQ3.

j Exit and restart Windows for the
driver changes to take effect.

Driver Installation under
Windows 3.1
a Launch Windows and open the
Control Panel, located in the Main
program group.

b Double-click the Drivers option.

c When the list of installed drivers
appears, click the Add button.
A dialog appears presenting a list of drivers included with Windows.

h In the following dialog, click Finish to
proceed with driver installation.
After the necessary driver files are
copied from your floppy disk, the driver
setup dialog opens.

d Select Unlisted or Updated Driver
and click OK.

e As prompted, insert the
Studio 64 XTC PC disk and specify
Figure C.1: Studio 64 XTC setup dialog
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the letter of your floppy drive (usually
either A:\ or B:\). Click OK.

CHANGING DRIVER SETTINGS

Windows accesses the disk and after a
brief delay, a list of drivers on the disk
appears.

If necessary, COM port and IRQ settings
may be changed in the driver setup
dialog.

f Select the Studio64XTC entry and
click OK.

Changing Driver Settings under
Windows 95
To change driver settings under
Windows 95:
a From the Windows 95 taskbar, choose
Start>Settings>Control Panel.
After the necessary driver files are
copied from your floppy disk, the driver
setup dialog opens.

b Double-click the Multimedia option.
The Multimedia Properties dialog opens.

c Click the Advanced tab and then
double-click MIDI Devices and
Instruments.
A list of installed MIDI drivers appears.

d Select any entry for the Studio 64 XTC
and click the Properties button.
The Driver Properties dialog opens.
Figure C.2: Studio 64 XTC setup dialog

g In the driver setup dialog, enter the

e Click the Settings button to open the
driver setup dialog for the
Studio 64 XTC.

COM port and IRQ for your
Studio 64 XTC connection. Click OK.

f In the driver setup dialog, enter the

Generally, COM1 and COM3 default to
IRQ4, while COM2 and COM4 default to
IRQ3.

g Exit and restart Windows for driver

h Exit and restart Windows for the

COM port and IRQ for your
Studio 64 XTC connection. Click OK.
changes to take effect.

driver changes to take effect.
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Changing Driver Settings under
Windows 3.1

Removing the Driver under
Windows 95

To change driver settings under
Windows 3.1:

First, remove driver in Control Panel:

a Launch Windows and open the
Control Panel, located in the Main
program group.

b Double-click the Drivers option.
A list of installed drivers appears.

c Select the entry for the Studio 64 XTC
and then click the Setup button.
The Driver Setup dialog opens.

d In the driver setup dialog, enter the
COM port and IRQ for your
Studio 64 XTC connection. Click OK.

e Exit and restart Windows for driver
changes to take effect.

a From the Windows 95 taskbar, choose
Start>Settings>Control Panel.

b Double-click the Multimedia option.
The Multimedia Properties dialog opens.

c Click the Advanced tab and then
double-click MIDI Devices and
Instruments.
A list of installed MIDI drivers appears.

d Select any entry for the Studio 64 XTC
and click the Properties button.
The Driver Properties dialog opens.

e Click the Remove button; then in the
following warning prompt, click Yes.

f In the Device Removed dialog box,
again click the OK button.

REMOVING THE WINDOWS
DRIVER
If for some reason you need to remove the
driver for the Studio 64 XTC, follow the
steps outlined below.

Windows prompts you that changes may
not take effect until restarting.

g Click OK.
h Exit and restart Windows for
changes to take effect.

IMPORTANT: Before executing these edits
you should make a backup copy of your
“System.ini” file, located in your Windows\System directory.

88

Opcode Systems, Inc.

APPENDIX C: Windows Drivers

Next, delete the driver files, Stu64xtc.drv
and Stu64xtc.386:

Removing the Driver under
Windows 3.1

a From the Windows desktop, navigate

First, remove driver in Control Panel:

to the Windows/System folder.

b Locate the files “Stu64xtc.drv” and
“Stu64xtc.386.”

c Drag both files to the Recycle Bin.
d Empty the Recycle Bin.
Lastly, edit your System.ini file:
a From the Windows desktop, navigate
to the Windows folder.

b Locate the file “System.ini” and
double-click it.

c Once Notepad is launched and
displaying the System.ini file, locate
and delete the following lines:

a Open the Control Panel, located in
the Main program group.

b Double-click the Drivers option.
A list of installed drivers appears.

c Select the Studio 64 XTC driver and
click the Remove button.

d In the following warning dialog click
Yes.

e When prompted to restart Windows,
click the Restart Now button.

Next, use the File Manager program to
delete Stu64xtc.drv and Stu64xtc.386:
a After restarting Windows open

device=stu64xtc.386
midiX=stu64xtc.drv (if present)

File Manager, located in the Main
program group.

b Navigate to the Windows\System
X = number specific to your system.

d To save changes to the System.ini
file, choose File>Save.

e Choose File>Exit to close Notepad
program.

f Restart Windows for all changes to
take effect.

directory and locate the files
“Stu64xtc.drv” and “Stu64xtc.386.”

c Control-click to select both files and
choose File>Delete.

d When asked to confirm your delete,
verify you are deleting the correct
files and click OK.

e Choose File>Quit to close the
File Manager program.

Lastly, edit your System.ini file:
a Open the Notepad program, located
in the Accessories program group.

b Choose File>Open.
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c In the Open dialog box, navigate to
the Windows\System directory,
select the “System.ini” file and click
Open.

d In your System.ini file, locate and
delete the following lines:
device=stu64xtc.386
midiX=stu64xtc.drv (if present)
(X = number specific to your system)

e To save changes to the System.ini
file, choose File>Save.

f Choose File>Exit to close the
Notepad program.

g Restart Windows for all changes to
take effect.
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SETTING UP YOUR SERIAL
PORT INTERFACE
When connecting the Studio 64 XTC to
your PC, you must specify which COM
port it’s connected to, and which IRQ it
will use. Failing to do either of these correctly, will result in an error message
when launching the Program Editor on
the PC.
The following steps will assist you in identifying other serial devices on your PC
and which COM ports they occupy:
a Before hooking up the interface it is
important to make sure the serial port
that you are going to use is not being
used by any other peripheral devices
in your system (i.e. modems, serial
mouse, joysticks, hand held
scanners, etc.)

b If your mouse has a rectangular or
D-shaped plug, it is a serial mouse
which may conflict with the interface,
in which case you should proceed to
step 3.
If your mouse has a round plug then it is
a PS2 mouse and should not conflict
with the interface, in which case you
should proceed to step 4.
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c Look at the ports on the back of the
computer and locate which one the
mouse is hooked up to. Using the
documentation for your computer
determine the number (COM 1,
COM 2, etc.) of the port to which the
mouse is attached. Write this number
down.
If you are unable to determine the
number of the COM port to which the
mouse is attached you may be able to
get this information by going to the Start
Button > Settings > Control Panel >
System > Device Manager > Mouse.
Look on all pages of this driver information for any indication of the COM port,
Address or IRQ which the mouse driver
is configured to use. Write this information down.

NOTE: If you are still having trouble
determining which COM port your mouse
is using, contact the manufacturer of
your computer and they should be able
to help you determine which COM port
your mouse is using.

d Do you have a modem? If yes,
proceed to step 5. If not, proceed to
step 6.
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e You need to determine the number of
the COM port which is being used by
your modem. To do this go to the
Start Button > Settings > Control
Panels > System > Device Manager >
Modem. Look on all pages for any
information about the Port, Address
or IRQ which the modem driver is
configured to use. Write this
information down.

NOTE: If you are having trouble finding
this information contact the manufacturer
of your modem or computer. They
should be able to help you determine
which COM port your modem is attached
to.

f You should now have a written list of
the COM ports which are in use by
your mouse and modem.
If you have no other serial port peripheral devices attached to your computer
then you are ready to proceed to step 7.
If you have other serial port devices then
you need to determine which COM ports
those devices are attached to and write
that information down and then proceed
to step 7.

g If your list shows no COM ports are in
use, proceed to step 9. If your list has
one COM port in use, proceed to
step 8.
If your list contains two or more items
then you are going to need to make
some adjustments before you will be
able to install the Interface. This is due to
the fact that COM 1 and COM 3 share
IRQ 4 and COM 2 and COM 4 share
IRQ 3. While each individual COM port
has a distinct Address which can be
used by the Interface, the Interface will
not share an IRQ with another device.
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You will need to either remove one of the
devices (and its corresponding drivers)
that is currently hooked up to one of the
serial ports or purchase an after market
Serial Port Card which is configurable for
an IRQ and address that are not being
used by any other devices in your system. Once installed this card will give
you an extra serial port to which you can
attach any serial port device. Proceed to
step 8.

h Based on your list of COM ports in
use you will now select a COM port to
use for your interface. Choose a COM
port and IRQ that are not already in
use by another device.

NOTE: Generally, COM 1 and COM 3
share IRQ 4 and COM 2 and COM 4
share IRQ 3. If you are using an after
market serial port card make sure that
the IRQ and Address for which the card
is configured are not used by any other
devices in your system. The
Studio 64 XTC driver currently supports
only COM ports 1 through 4.

i With the computer turned off, remove
any software keys, dongles, or
switchboxes from the COM port which
you are going to connect to the
Interface.

j Attach the interface to the computer
using the cable that came with the
interface and if needed the 9-Pin to
25-Pin adaptor. Plug in the power
adaptor for the interface.

k Turn on the interface and computer in
that order.

l Run the installer from the driver disk
that came with the interface, by
double clicking on the setup icon
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which appears on the disk in
Windows Explorer.

m When prompted enter the address
and IRQ of the COM port to which the
interface is attached.

n Reboot your computer with the
interface on when the installer
finishes installing the driver.

o You are now ready to start using the
patchbay software included with the
Interface or your sequencing
software.
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APPENDIX E: OMS Studio Patches for
Macintosh

WHAT ARE STUDIO PATCHES
Studio Patches route (and process) MIDI
data to and from instruments contained in
your current OMS Studio Setup document. Studio Patches, which are created
and edited with the Studio Patches Editor
application, are stored in Patch documents on your hard drive.
Each Patch document may contain:
•
•
•
•
•

Up to 128 patches
Any number of Virtual Controllers
Any number of Virtual Instruments
Any number of Program Change
Sources
A Patch Chain

Patches can perform a wide range of
MIDI processing and are constructed by
connecting various modules together in
the Studio Patches Editor. The patch
modules include splitters (for channels,
note range, and velocities), modifiers (for
velocity, mono/poly aftertouch, and controller values), a transposer, and a control
number mapper.
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Virtual Controllers and Virtual Instruments are extremely powerful features of
Studio Patches. A Virtual Controller is the
output of a MIDI device plus some form of
MIDI processing. A Virtual Instrument is
some form of MIDI processing routed to
one or more MIDI devices. Virtual Controllers and Virtual Instruments can be
valuable aids for both sequencing and live
performance.
Program Change Sources allow you to
specify various ways to change Studio
Patches.
A Patch Chain is a sequence of patches
that can be stepped through with a MIDI
controller, or the Studio 5’s optional
footswitches.
Patches are strictly real-time, live-playing
MIDI connections; they do not actually
affect the MIDI data that an application
sends or receives. MIDI applications will
always receive from the sources to which
they are connected and be able to send to
any destinations, regardless of what the
current patch does.
Since most sequencers provide MIDI thruing from within the application, you may
wish to keep Studio Patch #1 as an “empty”
or “do nothing” patch for use with
sequencer programs.
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PART 4: Appendices

Compatible MIDI Interfaces
To use Studio Patches you must have an
Opcode Studio 5, Studio 4, Studio 64X or
Studio 64 XTC. Below are some important
details, specific to each interface, that you
should know.
•

•

•
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Studio 5: The Studio 5 has built-in
RAM that can store a Studio Patch
document. This means that the
Studio 5 can use Studio Patches
(recalled from its front panel) without
being connected to a computer.
Studio 4: In order to use Studio
Patches, this interface must be connected to your Macintosh and an
OMS application must be launched.
Studio Patch processing occurs in
addition to any processing performed
by the Studio 4’s Routing, Channelizing and Muting window. When first
learning to use Studio Patches, you
may want to disable all routings in
this window.
Studio 64X, Studio 64 XTC: In
order to use Studio Patches, this
interface must be connected to your
Macintosh and an OMS application
must be launched.
Studio Patch processing occurs in
addition to any processing performed
by the Studio 64’s User/Preset Programs, as defined in the Program
Edit Window. When first learning to
use Studio Patches, you may want to
disable all routings in this window.

NOTE: Although Studio Patches require
one of the above mentioned interfaces, you
can use devices that aren’t attached to your
interface (such as a SampleCell card) in
Patch documents.
For a complete and thorough explanation
on creating and using OMS Studio
Patches, consult the PDF version of the
Studio Patches Manual included with
your Studio 64 XTC package.
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